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1 Introduction

1.1 Overview

Weather Message .Net  3.0  is a full-featured weather alerting software package.   Utilizing data
streams from the National Weather Services, Weather Message provides the ability to view
weather text and weather graphics on computers connected to a network with audible alerts for
severe weather; provides a map for seeing a visual representation of weather alerts; can send
abbreviated or full text weather messages to pagers, e-mail addresses, and fax machines;
archives weather products locally or to a website; retrieves radar images; and has the ability to
activate electrical devices using X10 control.

Weather Message operates as a server for connected clients.  The message viewer, image
viewer and map are considered clients.  These clients can be run on the same computer as the
server or located on a number of computers on your network.

Weather Message works by receiving weather products from the National Weather Service
EMWIN data stream, Weather Wire Service, or NOAAPort.  For additional information, see What
is EMWIN, What is Weather Wire, and What is NOAAPORT.  Weather Message can receive
weather products from satellite, radio modem, or Internet.  The received weather products are
processed against alarms you setup in Weather Message.

Why would you want to use Weather Message?  It allows you to send abbreviated messages to
pagers and cellular phones, in addition, it allows you to send weather products to other
computers on your network and even ftp weather messages and warning maps to a website.
Weather Message Server, Message Client and Weather Message Map run in the background on
the client computers.

Weather Message can be downloaded from the Internet and has a 30-day evaluation period.
You can download it at http://www.wxmesg.com .

Copyright © 2007 Weather Message Software

1.2 Data Warning

Warning
Due to the nature of the EMWIN , Weather Wire , and NOAAPORT  data streams, it is possible, on
rare occasions, for weather messages to be missed or not processed.  This can be caused by
satellite black out, technical problems, weather conditions, poor Internet connections or corrupted
messages.  Weather Message  makes deliberate attempts to process all received messages, even
those that may have been corrupted.  Because of this, the expiration times of some messages may
be set to a default of 30 minutes or 72 hours.  With any watch or warning, you should read the text
of the message to validate the expiration time.
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1.3 Obtaining Help

Email Support
If you need help with Weather Message, send an email to help@wxmesg.com.

Mail Support
You can reach the program author by mail to Weather Message Software, 203 Old Shepard
Road, Dadeville, Alabama 36853.

Weather Message Website
You can check for software updates and information on the Weather Message Website.

Discussion Group
A Yahoo Discussion Group has also been established for users to exchange ideas and help each
other.  You can join this group at http://groups.yahoo.com/group/WxMesg/join.

1.4 Installation

Weather Message can be purchased on CD or downloaded from the website.  The CD will
automatically load the installation program. If you download the software from the Internet, you
will need the full installation executable.  It contains all of the files necessary for a full installation.
A Quick Start guide can be downloaded from the website to assist you with installation and initial
setup.

Updates to the software can also be downloaded from the Internet.  The program updates only
contain changes to the Weather Message programs.  It cannot be used for a full installation.

Weather Message can be uninstalled using the standard Windows Add/Remove Programs
facility.  The uninstaller will not delete files created while running Weather Message.  After
uninstalling the software, you can safely remove the WxMesgNet directory.

Weather Message features a full 30 day fully functional evaluation.  During the evaluation period,
all aspects of the software function normally.  At the end of the 30 day evaluation, the software
will display an message, asking you to register the software.

Note:  If your installation will use multiple user login names/profiles, we recommend that you
install Weather Message using the administrator login.  This will insure that all users have
access to the programs.

Note:  It is not necessary to uninstall a previous version of Weather Message before installing
an updated software version.  Uninstalling the software will delete your operating setup
information.
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2 Weather Message Server Setup

2.1 Overview

The Weather Message Setup program is used to configure the operation of Weather Message.  It
has a number of options that are detailed in this manual.  The default installation is pre-
configured to work immediately and alarm all received weather products.

Weather Message processes received weather products based on alarms that you configure.
Only products that match your alarms will be processed.

2.2 Menu Options
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The menu buttons perform these functions:

The File menu allows you to export and import the program registry values, print the alarm and
group settings and exit the program.

• The Export Settings option will export all of the registry settings for the Weather Message
programs.  They are exported to WxRegSet.txt.  By exporting the registry settings, you to
easily backup the weather message directory and save all of your settings.

• The Import Settings option will import the registry settings contained in the WxRegSet.txt
file.  After the registry entries have been imported, the setup program will exit.  When you
restart the setup program, the imported registry values will be used.  You should stop all of
the weather applications before importing settings.

• The Print Settings option will print the alarm, email, fax, and paing group setup information.
• The Exit and Save option saves any changed data and exits the program.
• The Exit option exits the program without saving any alarm changes.

The Support Setup menu allows you to change the systems settings.

• The Fax Groups option allows you to setup fax groups and fax associated settings.
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• The E-Mail Groups option allows you to setup email groups and fax associated settings.
• The Paging Groups option allows you to setup fax groups and fax associated settings.
• The Options option allows you to specify general program operation settings.
• The Special Prefix option allows you to establish prefixes that can be used to alarm more

than one product per alarm.
• The Product Specifications option allows you to establish and maintain short message

formats by product.
• The WxWords option allows you to edit the word replacement file.

The Register menu allows you to register  Weather Message.  This button does not appear if
the software is registered.  Note: If the software is not registered after 30 days, it will stop
functioning.

The Help menu allows you to see this manual, and display information about the program.

2.3 Main Window

The main setup window allows you to configure the general program operation, along with
product alarms.

43
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The main screen is used to setup the TCP/IP Port address that the clients will use to access the
Weather Message Server.  Weather Message uses the port specified plus the next sequential
port number.  If you specify port 9501, the program will also use port 9502.

The Ingest Path field contains the directory path where received weather files are initially stored.
Weather Message Server looks in this directory for incoming files to process.  This path is used
by the Internet ingest (WxByte), serial port ingest (WxIngest), weather wire ingest (WxWw2000) ,
and NOAAPort (WxPort) programs to store received weather files.

The Data Path field contains the directory path to store processed text weather messages.  The
Graphics Path field contains the directory path to store processed graphic products.

The Alarm File # field allows you to select from 1 to 9 different alarm files.  Only one alarm file is
active at a time.  This option is useful if you want to define a different set of alarms for different
times of the year.

Select the Ingest Engine(s) to automatically start when Weather Message Server is loaded.
Check WxIngest Serial to start the EMWIN serial port ingest program.  Check WxByte Internet to
start the EMWIN Internet ingest program.  Check Weather Wire to start the Weather Wire ingest
program.  Check NOAAPort to start the NOAAPort ingest program.

Note:  Weather Message supports simultaneous ingesting from all data sources.  If you want
to receive data from multiple sources, select each source as appropriate.  Weather Message
will filter duplicate messages so they will not be alarmed twice.  Simultaneous ingesting
provides a level of redundancy.

When the Save button is clicked, the Ingest, Data and Graphics paths are validated.  If they do
not exist, a message box will appear asking you if they should be created.
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This screen also contains a grid for entering alarms.  The alarms displayed in the grid are from
the alarm file selected in the Alarm File # field.   The alarm grid can be sort by clicking on the
column header.  Click once for descending order, click again for ascending order.

Hint:  The widths of the alarm columns can be changed.  To change a column width, position
your cursor over the column line, hold down the left mouse button and drag the column line.

Hint:  The location of a column can be changed by dragging the column to another location.

Hint:  Inactive alarms are shown in the alarm grid with a yellow background.

Weather Message supports 1000 alarms, 500 e-mail groups, 500 fax groups and 500 pager
groups.

Note:  Changing any of the alarms will cause the setup program to notify Weather Message
Server that changes have occurred.  The Server will reload the current alarm file.  You will see
the message "Loaded Alarm Table" on the Weather Message Server status screen.  If you
change the TCP/IP port, you must stop and restart Weather Message Server.

2.4 Support Setup

2.4.1 Fax Groups
2.4.1.1 Fax Settings

The Fax Setup window allows you to set the faxing program to use along with your fax groups.

Select the program that you will use to send faxes.  Select Windows 2K/XP to use the integrated
fax server in Windows 2000, 2003 and XP.  Select Win Fax Pro to use WinFax Pro, by
Symantec.

Enter your name in the Fax Name From field.  Enter your fax telephone number in the Fax
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Telephone # field.

The Create Fax Header/Trailer button allows you to create text that will be added to the
beginning and end of "selected" and "full" fax messages.  See Message Header/Trailer  for an
example.  When you click on this button, a screen will be displayed to enter the header and
trailer.  If you only want a head/trailer message for certain groups, see the Fax Group  section.

Hint:  Clicking on one of the column headers will sort the list for that column.

Note:  WinFax Pro is not provided with Weather Message.  This third party software can be
purchased directly from Symantec.

Note:  For faxing to work properly, you must have your faxing software setup properly.  It is
recommended that you test your faxing software setup before instructing Weather Message to
send faxes.

To edit an exiting group, double click the group.  For other options, select the group and right
click to see these menu options.

• The Add option will add a new group.
• The Edit option will edit the selected group.
• The Delete option will delete the select group.
• The Copy option will copy the selected group.
• The Paste option will paste the last copied group as a new group.

2.4.1.2 Fax Group

The Edit Fax Group window allows to setup a group to receive faxes.

42
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Enter the name of the group to be setup in the Group Name field.  This name will appear in the
alarm setup window as an available fax group.

Select the Style of fax to send.  Select Selected for selected text from the alarmed UGC group;
Selected No Head for selected text from the alarmed UGC group without the header; Full for
Full Text; Full No Head for Full Text without header

Hint:  The No Head style option removes the heading lines from the messages.  This option
removes all of the heading text from the first line in the message or UGC group down to the
issued date/time line.

The Subject Style allows you to specify how the fax subject line is formatted.  Full gives you the
description, for example, "Tornado Warning".  Product gives you just the product (AWIPS) code,
for example, "TORBHM".  The None option causes the faxing program to not include a subject
line.

The Parse option can be used to reduce the size of the fax messages sent.  Selecting "Y" tells
the system to parse the messages, for this group, against the WxWords word substitution file.

Enter the fax telephone numbers in the Fax List box.  Put one fax number per line.  You can also
enter a name associated with each address by following the fax number with a single space, then
the name.  Entering a name will help you identify the person associated with the fax number.

Hint:  If you are required to dial a nine to obtain an outside line, you can insert a "P" after the 9
to cause the modem to pause for a second dial tone.  For example:  9P3292952.

The Create Group Fax Header/Trailer button allows you to create text that will be added to the
beginning and end of "selected" and "full" fax messages for this group.  When you click on this
button, a screen will be displayed for you to enter the header and trailer.  See Message
Header/Trailer  for an example.42



Weather Message Server Setup 19

© 2007 Weather Message Software

2.4.2 Email Group
2.4.2.1 Email Settings

The Email Setup window allows you to set the email server information along with your email
groups.

Enter the name of your SMTP Server and your E-mail Address.  The E-Mail From field can be
used to attach your agency name and/or abbreviation.  This field will be shown in the e-mail From
field.

The Email Options button is used to setup SMTP port, authentication, retries, and backup e-mail
servers.  See Email Options .

The Create E-Mail Header/Trailer button allows you to create text that will be added to the
beginning and end of all "selected" and "full" email messages.  See Message Header/Trailer
for an example.  When you click on this button, a screen will be displayed for you to enter the
header and trailer.  If you only want a header/trailer message for certain groups, see the Email
Group  section.

Hint:  Clicking on one of the column headers will sort the list for that column.

Note: When you are ingesting from the Internet, WxByte uses the email address entered on
this screen to validate you as a user.

To edit an exiting group, double click the group.  For other options, select the group and right
click to see these menu options.

20
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• The Add option will add a new group.
• The Edit option will edit the selected group.
• The Delete option will delete the select group.
• The Copy option will copy the selected group.
• The Paste option will paste the last copied group as a new group.

2.4.2.2 Email Options

The Email Options window allows you to set STMP port, authentication, retries and backup e-
mail servers.

The SMTP Port defaults to port 25.  If your ISP uses a non-standard port, enter that port number
in this field.

The Send Using BCC field should be checked if you want to send email using the email field
BCC (Blind Carbon Copy).  The email program normally sends email using the email field To.
Using the BCC email field prevents each email address that you entered for a group from
appearing in each email.

The Priority Flag field should be checked if you want to the recipients email to be flagged as
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priority.

Hint:  Some spam filters may flag messages with priority flags as spam.  If you run into a
problem with a spam filter, uncheck this option.

The Append Time check box is used to add a date and time to the email subject.  This option
can be used with email forwarding software that does not forward email messages with duplicate
subject lines.

Some ISPs require that you authenticate your connection when you connect to their SMTP
servers.  If your ISP has this requirement, enter your User Name and Password in the Primary
SMTP Authentication fields.

Hint:  Use the SMTP authentication fields if they are required, otherwise leave them blank.  If
your ISP does not require authentication and you enter a user name and password, connection
attempts to your email server will fail.

In the event that an email message cannot be delivered, you can specify the number of times the
software will attempt to deliver the message.  Enter the number of retries in the Failure Retries
field.  Enter the number of minutes between retries in the Retry Minutes field.

The Backup Server and Backup SMTP Authentication fields can be used for a backup email
server.  In the event that the primary server fails to respond, the software will automatically switch
to the backup server.

2.4.2.3 Email Group

The Edit Email Group window allows to setup a group to receive emails.

Enter the name of the group that you are creating in the Group Name field.  This name will
appear in the alarm setup window as an available email group.
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Select the Style of email to send.  Select Short for a short message; Selected for selected text
from the alarmed UGC group; Selected No Head for selected text from the alarmed UGC group
without the header; Full for Full Text; Full No Head for Full Text without header

Hint:  The No Head style option removes the heading lines from the messages.  It removes all
of the heading text from the first line in the message or UGC group down to the issued
date/time line.

The Subject Style allows you to specify how the fax subject line is formatted.  Full gives you the
description, for example, "Tornado Warning".  Product gives you just the product (AWIPS) code,
for example, "TORBHM".  The None option causes the faxing program to not include a subject
line.

The E-mail messages can be broken down into small packets to be sent to cellular phones and
pagers.  These devices normally cannot receive a large email message.  Entering 0 (zero) for
Size will tell the system to not break the message down into packets.  In addition, you can limit
the number of these packets you want to send, by specifying that number in the Maximum field.
Entering 0 (zero) for Maximum will tell the system to send all of the packets.

The Parse option can be used to reduce the size of email messages sent.  Selecting "Y" tells the
system to parse the messages, for this group, against the WxWords word substitution file.

The Time Zone option allows you to select the time zone for this group.  This option is used
when the Style is set to Short.  The system will adjust the received message to the selected time
zone.

Enter the email addresses in the E-mail List box.  Put one e-mail address per line.  You can also
enter a name associated with each address by following the email address with a single space,
then the name.  Entering a name will help you identify the person associated with the email
address.

The Create Group E-Mail Header/Trailer button allows you to create text that will be added to
the beginning and end of "selected" and "full" e-mail messages for this group.  When you click on
this button, a screen will be displayed for you to enter the header and trailer.  See Message
Header/Trailer  for an example.

The Create Group Short Message button allows you to create a short message for this group.
This option allows you to modify the system short message format for this group.  See Short
Message  for additional information.

Note:  If you enter a short message for a group, it overrides the default and product specific
specifications.

2.4.3 Paging Groups
2.4.3.1 Paging Settings

The Paging Setup window allows you to set the paging information along with your paging
groups.

42
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The Paging Options button is used to setup the paging subsystem.  See Paging Options .

The Paging Services button is used to setup paging service providers.  Paging services must be
established before adding paging groups.  See Paging Services .

The Create Pager Header/Trailer button allows you to create text that will be added to the
beginning and end of "selected" and "full" pager messages.  See Message Header/Trailer  for
an example.  When you click on this button, a screen will be displayed for you to enter the
header/trailer.  If you only want a header/trailer message for specific groups, see the Editing
Paging Groups section.

Note:  Weather Message removes all control characters from messages sent to a pager.  Most
paging companies do not allow embedded control characters.

Hint:  Clicking on one of the column headers will sort the list for that column.

To edit an exiting group, double click the group.  For other options, select the group and right
click to see these menu options.

• The Add option will add a new group.
• The Edit option will edit the selected group.
• The Delete option will delete the select group.
• The Copy option will copy the selected group.

24
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• The Paste option will paste the last copied group as a new group.

2.4.3.2 Paging Options

The Paging Options window allows you to set modem, SNPP and WCTP information.

.

Select the Serial Port that is attached to your modem.  The Retries field is used to specify the
number of times that the program will attempt to connect to your paging provider when their
modem line number is busy.   The Modem Initialization box is used to enter the initialization
string needed for your modem.

For SNPP Paging, enter the Default SNPP Port number.  Most paging companies use port 444
for SNPP connections.  The Connect Mode option, when check, causes the software to remain
connected to the SNPP server when sending a group of messages.

For WCTP Paging, enter the Default WCTP Port number.

Modem Initialization Strings

Modem initialization strings can be different for each modem manufacturer and in most cases are
different.  The following generic strings can be used with most modems.
Generic AT&FQ0V1X4&D2
Generic 14.4 & 28.8 AT&FQ0V1X4&D2N0S37=5
US Robotics AT&F0Q0V1X4&D2&B1&K0&M0&N2

Some US Robotic modems will not communicate with computers at slow baud rates.  If you
encounter problems with your US Robotics modem, use the above initialization string and set the
baud rate for your users and groups to 19200.
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In general your initialization string should do the following.
Send the attention command AT
Load factory defaults &F
Turn echo off E0
Enable result codes Q0
Display result codes as words V1
Enable extended result codes X4 (could be X0)
Enable modem hang up DTR change &D2

In addition, these options should be specified – they vary by manufacturer.
Turn off data compression
Turn off error correction
Turn off flow control

If these codes do not work with your modem, send e-mail to help@wxmesg.com.  Include your
modem model number and we will try to send you an initialization string that will work.

2.4.3.3 Paging Services

The Paging Services window allows you to setup different paging services.

To add a new service, click the New Service button and enter a new Service name.  To delete a
service, select the service from the drop down list and click the Delete button.  To change a
service, select the service from the drop down list.

The Service Type field allows you to specify the type of paging service.  Select TAP for modem
dial-up paging, SNPP or WCTP for direct Internet paging, HTTP Post or HTTP Get to interface
with a web page / web server, or PageGate if you want to interface with PageGate software.

Note:  The PageGate option will cause the software to create messages named "Page#.asc"



Weather Message Server26

© 2007 Weather Message Software

in the "C:\Program Files\WxMesgNet\WxData\PageGate" directory.  You should configure
PageGate to scan this folder for messages.

For TAP paging, enter the service Telephone Number, Baud Rate and Parity/Bits.  For SNPP,
WCTP, or HTTP paging, enter the service Address and SNPP Port, WCTP Port, or HTTP Port.

Most paging devices have a limitation on the number of characters they can receive in one page.
This limit is should be entered in the Maximum Page Size field.  Entering 0 (zero) for Size will
default to 80 characters.  Ask your paging provider for this limit.

Hint:  Some paging companies restrict the message size that can be sent to their pagers.  It
you exceed the size limitation the page request may be refused or rejected by the paging
company.  If your page requests are being rejected, try a shorter message length.

The HTTP Post and HTTP Get option allows you to interface directly with a web page or web
server.  The Post option posts variables to the web server.  The Get option URL encodes the
variables before appending them to the http address. These option requires a good
understanding of posting data to web servers and the paging providers webpage.  It is beyond
the scope of this manual to describe these requirements.  If you have questions contact Weather
Message Support.

For HTTP, you must enter the information and variables to be posted or URL encoded to the
HTTP server.  Enter the required information in the HTTP Post Variables field.  They are entered
in the format variable=value.  Three replacement variables are available to insert the pager pin,
group name and message.  Use the variable $Pin$ to insert the pager pin, $Group$ to insert the
paging group name, and $Message$ to insert the pager message.

The following is an example of the variables needed for the SouthernLinc HTTP server.

PageArea1=
PageNum1=$Pin$
From=EMWIN
PageMsg=$Message$
NumChars=
Page=Send Message

2.4.3.4 Paging Group

The Edit Paging Group window allows to setup a group to receive pages.
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Enter the name of the group to be setup in the Group Name field.  This name will appear in the
alarm setup window as an available paging group.

Select the Style of page to send.  Select Short for a short message; Selected for selected text
from the alarmed UGC group; Selected No Head for selected text from the alarmed UGC group
without the header; Full for Full Text; Full No Head for Full Text without header

Hint:  The No Head style option removes the heading lines from the messages.  This option
removes all of the heading text from the first line in the message or UGC group down to the
issued date/time line.

The pager messages can be broken down into small packets to be sent to cellular phones and
pagers.  These devices normally cannot receive a large email message.  Entering 0 (zero) for
Size will tell the system to not break the message down into packets.  In addition, you can limit
the number of these packets you want to send, by specifying that number in the Maximum field.
Entering 0 (zero) for Maximum will tell the system to send all of the packets.

Hint:  Some paging companies restrict the message size that can be sent to their pagers.  It
you exceed the size limitation the page request will be refused or rejected by the paging
company.  If your page requests are being rejected, try a shorter message length.

The Parse option can be used to reduce the size of email messages sent.  Selecting "Y" tells the
system to parse the messages, for this group, against the WxWords word substitution file.

The Time Zone option allows you to select the time zone for this group.  This option is used
when the Style is set to Short.  The system will adjust the received message to the selected time
zone.

Select a paging service provider from the Service Name drop down list.  See Paging Services
to add a new service.

Enter the email addresses in the Pager Pin List box.  Put one pin per line.  You can also enter a

25
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name associated with each ping by following the pin with a single space, then the name.
Entering a name will help you identify the person associated with the email address.

The Create Group Pager Header/Trailer button allows you to create text that will be added to
the beginning and end of "selected" and "full" pager messages for this group.  When you click on
this button, a screen will be displayed for you to enter the header and trailer.  See Message
Header/Trailer  for an example.

The Create Group Short Message button allows you to create a short message for this group.
This option allows you to modify the system short message format for this group.  See Short
Message  for additional information.

Note:  If you enter a short message for a group, it overrides the default and product specific
specifications.

2.4.4 Data Alerts

The Data Alerts window allows you to configure the software to notify a group of people if it does
not receive data for a specific period of time.

To activate data alerting, set the number of minutes that the program should wait, without
receiving data, before sending an alert.   You can specify a Pager Group and Email Group to
receive the message.  The program will send a brief message indicating it is no longer receiving
data.  The message will also includes the name of the computer.  When data resumes, you will
get a second message indicating that it has resumed.

2.4.5 Options
2.4.5.1 General Tab

The Option's General Tab contains general settings for the server.

42
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The Show Errors check box, when checked, will cause the software to pop-up an error box
when a problem is encountered during program operation.  Regardless of this setting, all errors
are logged to the log file.

The UnZip Files check box, when checked, will cause the software unzip received compressed
files.  Files with the extensions "zis" and "zip" will be uncompressed when this option is enabled.
This option is checked by default.

The Show Message Decode option, when checked, will cause Weather Message Server to
show detailed information in the server window about each message as it is decoded.  This
option is only used for debugging and should not be used for normal operation.

The Email/Page Use Upper Case option, when checked, will cause all email and paged
messages to be sent in upper case.

The Email/Page Add Delimiter option, when checked, will cause the program to add a comma
between county names when using the short message option.

The Log File Size field allows you to specify this size of your Weather Message log files.  The
default is 50,000 bytes.

The Daily Logs option, when checked, causes the program to store the log files for each day in
the ..\WxMesgNet\WxLogs directory.  The logs for each day are copied to this directory.  The log
file name is appended with the day number.  These logs will be overwritten with the next month's
logs.  After enabling this option, you must restart all Weather Message programs.

Note:  Enabling the Daily Logs option disables the log file size option.

The Setup/Shutdown Password, if entered, will cause the Weather Message Server, WxByte,
WxIngest and WxRadar programs to prompt the user for a password before stopping the
respective program.  The Weather Message Server Setup program will also require this
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password before allowing setup options to be changed.

Hint:  Entering a password will prevent the server and ingest programs from being accidentally
shutdown.

The Server Name field is used to record a name for your Weather Message Server.  The server
name is transmitted to each connected client.

2.4.5.2 Collectives Tab

The Option's Collectives Tab allows you to optionally store collectives in a user defined directory.

The software currently supports the SAHOURLY collective.  Enter the directory path to store this
file.

2.4.5.3 FTP Ingest Tab

The Option's FTP Ingest Tab allows you to configure FTP ingesting of EMWIN data.
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The FTP Ingest on Startup, when checked, will cause Weather Message to automatically request
the three hour file when the program is first launched.

Hint:  This option pre-loads the system with the last three hours of EMWIN data.  This can be
used when Weather Message is not run continuously.

The FTP Ingest Interval allows you to specify whether you want the software to automatically
request FTP files for ingesting.  You can select these options; None for no FTP Ingesting, 15
Minutes for FTP Ingesting every 15 minutes, 1 Hour for FTP Ingesting every hour, and 3 Hour for
FTP Ingesting every 3 hours.

Note:  FTP Ingesting requires an Internet connection.

2.4.5.4 Protocols Tab

The Option's Protocol Tab allows you to configure the protocols used by Weather Message.
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The FTP – Use Passive Mode option, when checked, will cause the ftp program to use the
passive mode.  This option may be needed for firewalls that restrict incoming connections.

The FTP Timeout field allows you to specific the maximum amount of time the program will wait
for responses from ftp servers.

The FTP – Absolute Timeouts option, when checked, will cause the ftp program to use absolute
timeouts.  An absolute timeout requires the ftp software to complete a ftp command within the
timeout seconds specified.  When unchecked, the ftp software will use normal timeouts.  Normal
timeouts are based on communication activity between the ftp software and the ftp server.

The HTTP Timeout field allows you to specific the maximum amount of time the program will
wait for responses from http servers.

The TCP Timeout field allows you to specific the maximum amount of time the program will wait
for responses from clients connected to the Weather Message Server.  The default is 0 (zero),
wait indefinitely.  Use caution when changing this value.  If a value is entered, the Server will
disconnect clients that have not received data stored in the internal buffer within the specified
time.  The minimum time value allowed is 30 seconds.

The X10 Port field allows you to specify the serial port that is connected to X10 interface
hardware.  If X10 is not used, select an unused port.

The X10 Device field is used to select the type of X10 interface device connected to your system.
The valid options are CM17 and CM11.

The Firewall / Proxy button allows you to configure Firewall and Proxy settings for your
computer.  See Firewall / Proxy .33
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2.4.5.4.1  Firewall / Proxy

The Firewall / Proxy window allows you to configure firewall / proxy information for your
computer.

For a FTP firewall, enter the domain name or TCP/IP address of the firewall in the Host Name
field.

Enter the Port number for the firewall.

If required, enter a User Name and Password.  This should be a user name and password
setup in the firewall.

Select the Type of firewall.  Valid entries are 1-Tunnel, 2-Socks version 4, or 3-Socks version 5.

For a HTTP firewall, enter the domain name or TCP/IP address of the firewall in the Host Name
field.
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Enter the Port number for the firewall.

If required, enter a User Name and Password.  This should be a user name and password
setup in the firewall.

Select the Type of firewall.  Valid entries are 1-Tunnel, 2-Socks version 4, or 3-Socks version 5.

For a Proxy access, enter the domain name or TCP/IP address of the proxy in the Host Name
field.

Enter the Port number for the firewall.

If required, enter a User Name and Password.  This should be a user name and password
setup for the proxy.

If HTTP version 1.0 is required for the proxy server, check this box.

The Detect Proxy button will automatically detect the proxy settings for your computer and
populate the host name and port fields.

Note:  The Firewall / Proxy settings are common to all Weather Message applications.
Changing these settings will automatically change them for the other applications.

2.4.5.5 Purge Tab

The Option's Purge Tab allows you to configure the purge interval and product count for received
products.
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The Global Purge Time field specifies the number of hours to keep expired weather and graphic
products, before deleting them from the directories entered in Data Path and Graphics Path.

The Global Purge Count allows you specify the minimum number of products to keep on file
after the Global Purge Time as elapsed.

Individual Product Purging

Purge options can also be specified for individual products or wildcard patterns.  These options
override the global options.  To enter a new product identifier, click in the Product Id field on the
row that has the "*".  Enter the Hours and Count for this product.

The Product Id field supports the wildcard "?" and "*" characters.

To change an entry, click in the cell to be changed.  To delete an entry, select the row and press
the delete key.

Purge Option Combinations

Product purging give you three options:

• Hours > 0 and Count = 0
This purges the product based on the expiration time.

• Hours > 0 and Count > 0
This purges the product based on expiration time and product count. The program favors the
hours parameter first. That is it will always keep a product until the hours elapses, then it will
honor the count setting.

• Hours = 0 and Count > 0
This purges the product based on the count of products. If you set the count to 2 and 4
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product have been received in the last 30 minutes, the purge cycle will keep the last 2
product received and the previously received products will be deleted.

Note: Weather Message starts a product purge cycle every 30 minutes.

2.4.6 Printer

The Printer menu allows you to select a default printer and font size.

Click the Default Printer menu item to select a default printer.

Click the Default Font menu item to select a default font.

2.4.7 Special Prefix

The Special Prefix window allows you select products to be serviced by the WRN, WRO, WRP,
and WRQ prefixes.  These special prefixes are designed to assist you in alarming a group of
messages.   These prefixes can be used to reduce the number of alarms needed for commonly
alarmed products.

The prefix WRN defaults to the products FFW, SVR and TOR.  Enter additional products by
typing them into the list.

Note:  All of the products in this list must use the same UGC coding sequence - zone or FIPS.
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The prefixes WRO, WRP and WRQ have no assigned default values.  Select one of these
prefixes and enter  products by typing them into the list.

Note:  All of the products assigned to each list must use the same UGC coding sequence -
zone or FIPS.

2.4.8 Product Specifications

The Product Specifications window allows you establish short message formats for products.
These specifications are used to create a short message for email, paging and archive
operations.

The Default product specification is used for any short message that does not match a product in
the list.

Note:  You cannot delete the Default product.



Weather Message Server38

© 2007 Weather Message Software

To edit an exiting Product, double click the product.  For other options, select the Product and
right click to see these menu options.

• The Add option will add a new product specification.
• The Edit option will edit the selected product.
• The Delete option will delete the select product specification.

When adding, or editing, the Product Specification  window is displayed.

Hint:  Product Specifications can be entered for a three character product identifer, or a
complete 6 character product plus WFO identifier.

2.4.8.1 Short Message Tab

The Short Message Tab allows you establish a short message.

The Product field allows you to enter a product identifier.  This field is disabled for the Default
product.  The description of the product entered is displayed to the right of the product field.

The format of the message is established by typing words and codes in the first text box.  To the
right of the first text box, you will see a list of codes that can be used in the message.  The text
box at the bottom of the window shows a sample of the decoded format.
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The following is a list of the codes available and their meaning:

The $IfCounty:word$ and $IfExpire:word$ codes can be used to insert words if the message will
include county names and/or an expiration time.  In the example shown above, the code
"$IfCounty: for $", means to include the word "for", if county names are available, otherwise do
not include the word.  The "$IfCounty: County $", does the same, means to include the word
"County", if county names are available.

Using these codes you could construct a message that reads:  From Lee County EMA: At 13:30
NWS BHM issued a Tornado Warning for Lee County expiring at 14:00.  This flexibility allows
you to have a shorter or longer message, based on your requirements.

The $HeadLines$ code will include any headlines found in the alarmed message.  Headlines are
lines that begin with "…" and end with "…".  Headlines are not present in every weather
message.

The $BulletAT$ code will include any text found in the alarmed message after the text "* AT".
This code is useful with TOR (tornado) and SVR (severe thunderstorm) messages.  It captures
the location of the weather system causing the alarm.

The $Bullet$ code will include any text found in the alarmed message after the text "* ".  This
code is useful with several types of messages.  It captures the location of the weather system or
event causing the alarm.

The $Today$ and $Tonight$ codes will include the today and/or tonight information from the
Zone Forecast product.  Specifically,  $Today$ will pull all of the text associated with a line that
starts with ".TODAY" or ".THIS".  $Tonight$ will pull all of the text associated with a line that
starts with ".TONIGHT".

The $DayOne$ and $Spotter$ codes will include the day one and spotter attention lines from the
Hazardous Weather Outlook.  Specifically, $DayOne$ will pull the first paragraph after the ".DAY
ONE" header.  $Spotter$ will pull the first paragraph after the ".SPOTTER" header.

The $UserDef1$ code will include a paragraph of text, starting at the point where a user definable
string is found.  See the Options tab to setup the user definable string.

The $Lines:x,y$ code will include a fixed number of lines from a specified starting line in the
message.  X is the starting line in the message and Y is the number of lines to include.

Note:  The $Start variables can be blank if the incoming message is coded with no event start
time.

Note:  The HVTEC variables are only populated when the alarmed message contains HVTEC
encoding.

2.4.8.2 VTEC Tab

The VTEC Tab allows you specify a format for the description associated with VTEC coded
messages.
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The format of the $MesgType$ code is established by typing words and codes in the first text
box.  To the right of the first text box, you will see a list of codes that can be used.  The text box
at the bottom of the window shows a sample of the decoded format.

The following is a list of the codes available and their meaning:

$vProduct$ Product type – Operational, Experimental, etc.

$vAction$ Action – New, Cancelled, Extended, etc.

$vPhenomena$ Phenomena – Severe Thunderstorm, Tornado, etc.

$vSignificance$ Significance – Watch, Warning, etc.

$vEvent$ Event number used to track this message.

$vEventStart$ Event start time in local AM/PM format.

$vEventStart24$ Event start time in 24 hour format.

Note:  The $vEventStart variables can be blank if the incoming message is coded with no
event start time.

2.4.8.3 Options Tab

The Options Tab allows you to setup user definable text that will be used to populate the
$UserDef1$ short message code.



Weather Message Server Setup 41

© 2007 Weather Message Software

Enter the starting string sequence in the Start Sequence field and the stopping string sequence
in the Stop Sequence field.

These sequences must match the text exactly.  In the example above, the program will look for a
line that begins with ".Discussion" and is followed by any number of characters.  The "*"
character is used to indicate any number of characters.  It will stop capturing text from the
message when a blank line is encountered.

Hint:  If you want to find text that is in the middle of a line use the "*" character before and after
the text that you what to find.

2.4.9 WxWords

The WxWords Window is used to establish word substitutions.  These entries are used when the
Parse option is enabled on Fax, Email and Paging groups.  This capability is specifically
designed to reduce the size of paged messages.
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The format for WxWords is original word(s), replacement word.  There must be a comma
between the original word and replacement word.  You will notice that the comma is shown in a
different color.

Note:  The words are not case sensitive, however the program will replace the words in the
case that you use in WxWords.

Note:  A sample WxWords.dat file is available on the Weather Message Additional Downloads
webpage.  This file contains the most common abbreviations,
http://www.wxmesg.com/misdownloads.htm.

Since the format for WxWords uses a comma to separate the original word(s) and replacement
word(s), a special procedure should be used to replace a comma.  To replace a comma, you
must enclose the comma character with single quotes.  For example – to replace the comma with
a semicolon, your entry in WxWords would be ',',; .  To replace a semicolon with a comma, your
entry in WxWords would be ;,',' .

In order to remove carriage return and line feed characters, enter the line \n, . The \n string will
match any carriage return line feed characters, which can be replaced with nothing or any other
character string, include a blank space.

2.4.10 Message Header/Trailer

The Edit Header / Trailer window allows you to enter text that will be added to the beginning and
ending of a fax, email or pager message.
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The Header and Trailer are optional.

2.5 Register Software

The Register menu option allows you to register your software.

When you purchase Weather Message, you will be supplied with a Registration Name and
Registration Code.  Enter these exactly as they are printed.  These fields are case sensitive.

After the software is registered, we recommend that you stop and restart the software.

To purchase the software go to http://www.wxmesg.com/purchpay.htm.

2.6 Maintaining Alarms

2.6.1 The Alarm Grid

The alarm grid allows you to add, edit, delete, copy, paste and set alarms inactive.
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Hint:  Alarms that appear with a yellow background are inactive.

To edit an exiting alarm, double click the alarm.  For other options, select the alarm and right click
to see these menu options.

• The Add option will add a new alarm.
• The Edit option will edit the selected alarm.
• The Delete option will delete the select alarm.
• The Copy option will copy the selected option.
• The Paste option will paste the last copied alarm as a new alarm.
• The Set InActive option will disable an alarm.  You can also set and alarm inactive on the

alarm screen.

2.6.2 Alarm Tab

When adding or editing an alarm, this window is displayed.  The alarm tab contains the
information for selecting the weather products to alarm.
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The Product field contains the product identifier that you want to alarm.  The product identifier is
assigned by the National Weather Service.  It is commonly referred to as an AWIPS identifier.
Weather product codes / AWIPS identifiers are listed in Text Product Abbreviations.

Text message product codes are generally composed of a three-character message type,
followed by a three-character weather forecast office code.  There are some product identifiers
are four or five characters in length.  For example, the regional weather round up for Alabama is
RWRAL.  If you do not know whether a product uses four, five or six characters, look up the
weather forecast office's products using this Internet address
http://www.wxmesg.com/asp/recprod.asp.

Hint:  The product code can be an actual product code, or can contain question mark(s) (?) or
asterisk (*) for wildcard operation.

Hint:  The special prefixe, WRN, can be entered in the product code field to catch all of the
standard warnings.  It includes SVR, TOR and FFW.  This can be a time saver when
establishing your alarms.  Three additional special prefixes, WRO, WRP and WRQ, can also
be used.  These prefixes are not defined and can be setup using the Support Setup, Special
Prefix  menu option.

Hint:  To alarm METAR products, enter MTR as the first three letters of the product identifier,
followed by the four-letter station identifier.  For example to alarm the METAR for KALX, enter
MTRKALX for the product identifier.

Note:  If a message does not contain a valid Product identifier, the program will use the first six
characters of the WMO header.  This allows you to alarm products that do not have Product
identifiers.

In addition to text products, you can setup alarms for graphic products.  Graphic products cannot
be sent to the map, or paged.  They can be sent to the message client, emailed, archived and
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passed to an external exe program.  To alarm a graphic product, use its 8-character EMWIN file
name.

Hint:  The product identifier GRAPHI will match all graphic products.

To aid you with the entry of product identifiers, you can click on List Products to view and select
a product.  To view or select a weather forecast office, click on List Forecast Offices.

Note:  The product and forecast office list may not include all products or forecast offices
distributed by EMWIN, NWWS or NOAAPort.  The National Weather Service routinely updates
these lists.  As they are updated, they are incorporated into the next Weather Message
software release.  Check the Weather Message website for updates to these lists.

State / County / Marine Zone Selection

To select a specific state or marine zone, select the state or marine zone abbreviation from the
drop down list.  To aid you with the state or marine zone abbreviations, you can click on List
States to view and select a state or marine zone.

Note:  When using state or county selections, the weather message must contain the
appropriate Universal Generic Code (UGC) lines.  If you select a specific state or county and
the message does not contain a UGC line, it will be not be alarmed.  The only exception is the
SAW product.  Weather Message decodes the text in the SAW product so it can be alarmed by
state.

You can select any number of counties to be matched, for the selected state.  If no counties are
selected, the message will be alarmed if the state abbreviation is found in the message UGC
lines.

Hint:  A warning message will be displayed if you attempt to enter state or county information
for a message that does not normally contain UGC lines.

Hint:  The reason for allowing multiple counties on one alarm is to cover adjacent counties with
only one alarm.  This assists with the creation of a short pager message.  If no county is
specified, the short message will not contain any county names.

Text Matching

In addition to state and county preferences, you can require a message to have a specified text
phrase before it is alarmed.  The Match Text field allows you to enter a word or phrase that
should be found in the message before it is alarmed.

This feature can be used with messages that contain different content.  For example, the SPS
(Special Weather Statement) is used for different purposes.  One use of this message is to
announce thunderstorm advisories.  Entering "*THUNDERSTORM ADVISORY*" in this field, for
an SPS alarm, will require it to contain these words before it would be alarmed.

The Exclude Text field allows you to enter a word or phase that if found, would cause the
message to not be alarmed.  This feature can be used to prevent the alarming of test messages.
For example entering the word "*TEST*" in this field would prevent any message containing the
word "TEST" from being alarmed.

Hint:  The Match and Exclude fields use wildcards for matching.  Be sure to prepend and
append an "*".  The matching mechanism  supports ? to match Any single character, * to
match Zero or more characters, # to match  Any single digit (0–9), [charlist] to match  Any
single character in charlist and [!charlist] to match Any single character not in charlist.
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Alarm Active Option

The Alarm Active option is used to enable / disable an alarm.   When an alarm is disabled, it is
shown in the main alarm grid with a yellow background.

VTEC – Valid Time Event Code

The Set VTEC  button is used to setup specific VTEC events, primary and hydrologic, to be
matched for this product.

2.6.2.1 VTEC Option

The VTEC Settings window allows you to further define your alarm requirements for the product.
VTEC is not implemented in all messages.  A warning box is displayed if you attempt to set
VTEC options for a product that does not support this feature.

Primary VTEC

In order to use Primary VTEC, you must select at least one item from Products, Actions,
Phenomena and Significance.  You can select multiple items from each category.

The Select All Actions button will select all action items.  The Select All Significance button
will select all significance items.  The Clear Selections button will reset all selections for both
Primary and Hydrologic.

Note:  You can select Phenomena that may not be included in the message that is being
alarmed.  You need to verify that the message you are alarming can contain the Phenomena
that you select.

Note:  When you use the Primary VTEC option, the received message must contain the
Primary VTEC items you select, otherwise the message will not be alarmed.
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Hydrologic VTEC

Enter  Site Identifier(s) for the flood area. Select  Flood Severity(ies) from the drop down list.

Note:  Hydrologic VTEC is only found in hydrologic products.

Note:  These settings are optional.  If they are left blank, the software will alarm all products
that match your other alarm criteria.

Note:  When you use the Hydrologic VTEC option, the received message must contain the
Hydrologic VTEC items you select, otherwise the message will not be alarmed.

2.6.3 Client / Map / X10 Tab

The Client/ Map/ X10 tab is used to specify an alarm action for these categories.
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Message Client

The To Client field is used to indicate whether you want this alarm sent to the Message Client(s)
connected to the server.  Select "Yes" to send the alarm to all Message Clients, or select an
individual Message Client identifier.  Each Message Client can be set to a different identifier.
This allows you to send different alarms to individual Message Clients.

The Alarm Type field designates an alarm number for this alarm.  The Message Client and Map
Client use the Alarm Type to determine the sound that is played when the alarm arrives.  The
Message Client and Map Client will also use this Alarm Type to determine if their windows should
be made visible, if they are hidden.  Indicate your choice in the Alarm Type field.  The Message
Client and Map Client can play no sound, or your choice of 20.  You could assign alarm type 1 to
tornado warnings, type 2 to tornado watches, type 3 to severe thunderstorm warnings, 4 to
severe thunderstorm watches, etc.  The actual wave files that will be played and window popup
options are setup in each Weather Message Client.

Leaving the Alarm Type blank will cause the Message Client to show the message in it's text box,
however, if the screen is minimized, it will not popup the window to display the message. For
types 1 through 20, the Message Client will popup it's window, based on the client settings, if the
program is minimized.   See the Message Client and Map Client sections for additional
information on Alarm Types.

Map Client

The To Map field is used to indicate whether you want this alarm sent to the Map Client
computers connected to the server. Select "Yes" to send the alarm to all Map Clients, or select
an individual Map Client identifier.  Each Map Client can be set to a different identifier.  This will
allow you to send different alarms to individual Map Clients.

Note:  Only messages with UGC lines will be sent to the map client.

X10 Settings

The X10 Settings, along with the associated X10 hardware, can be used to activate electrical
devices when an alarm occurs.  Select a House Code, Command, Duration and appropriate
Units to activate.



Weather Message Server50

© 2007 Weather Message Software

The software supports the commands On, Off, All On, All Off, and Blink.

Hint:  The Blink option is implemented in software and works best with the CM11a controller.

The Duration field allows you to specify the number of minutes that a device should remain
activated.  Enter 0 (zero) for it to remain active until turned off.

Hint:  With VTEC coded messages; it is possible to turn on a device when a watch is issued
and off when the watch expires.

Note:  You should set the X10 Port and X10 Device in Support Setup Options before entering
alarms for X10 devices.

See the Weather Message website for additional X10 information and sources for X10 hardware.

2.6.4 Paging/Email/Fax Tab

The Paging/Email/Fax tab is used to specify an alarm action for these categories.

Paging

To send a message to a pager, you first have to establish your paging groups.  Weather
Message supports TAP, SNPP, WCTP protocols, along with a number of other speciality formats.
See the section on setting up paging groups.  After the groups have been established, select one
or more of the groups from the list.

Upon receiving a valid alarm for a pager group, Weather Message will send a message to the
pager group(s) based on the style you selected for the group.

If you selected the short message format and a "TORBHM" was issued with counties, ALC123
and ALC037, the paging message will read "NWS has issued a Tornado Warning for Tallapoosa
Coosa County until 07:00 PM".  Examples of the message formats can be seen in Paging / E-
Mail Formats.

Note:  If the alarm was only for Tallapoosa County, only the name Tallapoosa will appear.



Weather Message Server Setup 51

© 2007 Weather Message Software

The same goes for Coosa.  If both counties are in the weather message, then both will appear.
The format of this short message format can be changed from the Support Setup menu.

Note:  It is possible for you to select counties that may be in different groups in the alarmed
message.  Some weather products contain multiple groups that each contains counties.  In the
event that you select multiple counties and they are in different groups, you will get one
message for each group that contains a matching county.

If you use the Any County code, for example "ALC000", the short message will contain a list of
every county appearing in the weather message.  This can make the short message longer than
what will fit on a pager's display.

Note:  It is not recommended to use the all county code when you are sending "Selected" or
"Full" message text.  Doing so will result in an email/page being generated for each UGC line
in the weather message.

The file Product.dat, in the WxMesgNet directory, contains the descriptions of all weather
products.  This description appears in the short message and on the Message Client screen.
You can change any of these product descriptions to fit your particular application / need.

E-Mail

To Email a message, you first have to establish your e-mail groups.  See the section on setting
up email groups.  After the groups have been established, select one or more of the groups from
the list.  E-mail alarms work just like the pager and have the same format options.  Upon
receiving a valid alarm for an e-mail group(s), Weather Message will send a message to the e-
mail group(s) based on the style you selected for the group.

Hint:  Graphic products can be alarm to an Email group.  The graphic is attached to the Email
as an in-line file.

Fax

To fax a message, you first have to establish your fax groups.  See the section on setting up fax
groups.  After the groups have been established, select one or more of the group(s) from the list.
Fax alarms work just like the pager and have the same format options.  Upon receiving a valid
alarm for a fax group, Weather Message will send a message to the fax group based on the style
you selected for the group.

Time Restrict or Delaying Paging / E-Mail / Fax

The Time Restrict, Time Begin, Time End, and Days of Week fields are used to limit or delay
the times and days that a page, e-mail or fax can be sent for a particular alarm.  To restrict a
message to a defined time period, set the Time Restrict field to Yes.  Enter the begging time you
want to send the page, e-mail or fax.  Enter the time to stop sending the page, email or fax.
Select the days of the week that you want the page, e-mail or fax sent.

For example, you may not want an alarm paged or emailed from 22:00 hours through 07:00
hours.  The Time Begin field should be the time that you want paging/emailing started, in this
example 07:00.  The Time End field should be the time that you want paging, emailing or faxing
stopped, in this example 22:00.  Check all of the days of the week to receive that you want the
message sent.  From 22:00 through 07:00, messages will not be paged or emailed.

To delay a message until a later time, set the Time Restrict field to Hold.  Using the above
example, you want all message received from 22:00 through 07:00 to be delayed until 07:00.
The Time Begin field should be the time that you want paging/emailing started, in this example
07:00.  The Time Begin time is also the time that any held messages would be sent.  The Time
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End field should be the time that you want paging, emailing or faxing stopped, in this example
22:00.  From 22:00 through 07:00 messages will be held until 07:00.  At 07:00 any held
messages will be sent.  Any messages that arrive from 07:00 through 22:00 it will be paged,
emailed or faxed as soon as they arrive.

When the Time Restrict option is used, you must select the Days of Week that you want the
message sent.  Check the days that you want the message sent.  If a day is unchecked, the
message will not be sent.

2.6.5 Archive/Html/Exe/Print Tab

The Archive/Html/Exe/Print tab is used to specify an alarm action for these categories.

The Archive Action field indicates the style of message to archive.  Select No for no archiving;
Short for a short message; Selected for selected text from the alarmed UGC group; Selected
No Head for selected text from the alarmed UGC group without the header; Full for Full Text;
Full No Head for Full Text without header; or Raw for raw data.

Hint:  The No Head style option removes the heading lines from the messages.  This option
removes all of the heading text from the first line in the message or UGC group down to the
issued date/time line.

Hint:  For graphic products, use the Full option.

Note:  The Raw option is used by WxLoader to reconstruct a message from the individual
parts of a message.

The Archive Type field is automatically selected by the software based on the protocols selected
on the HTML Template  window.  This field can be blank or one of these options:  Local, Http,
or FTP

The Archive Path field contains the directory and file name to save.  The default archive type is
Local.  To save a file to a local directory, simply enter the directory path and file name to save in
the Archive Path field.  To use the Ftp or Http protocols, press the HTML Template button.
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An example of archiving to a local directory using the original EMWIN file name along with the
message expiration date/time would be  "c:\weather\$FileName$$Expire$$FileExt$".  This would
result in a file with a eight character EMWIN file name appended with the expiration date/time in
the format MMDDYYHHMM followed by the extension for the file.

Path / File Name Variables

The following variables are supported in the path / file name.

• $MM$ for the current two digit month.
• $DD$ for the current two digit day.
• $YY$ for the current two digit year.
• $FileName$ for the EMWIN base file name.
• $FileExt$ for the file extension.
• $Expire$ for the message expiration date and time.
• $Issue$ for the message issued date and time.

Hint:  The $MM$, $DD$, and $YY$ variables can be used to archive files to a directory
structure that includes one of the numeric date variables.  The variables are two digits in all
cases and have a leading zero when single digit is encountered.

Note:  The software does not create directories.  You will need to create the directory structure
prior to setting up the alarm.

Hint: The program normally overwrites duplicate files.  You can use the No Overwrite Archive
Option to add a sequential number between the file name and extension.

The Archive Options control whether the resulting message is overwritten or made unique if it
already exists.  Selecting the Overwrite option will cause the program to overwrite any existing
message.  The No Overwrite option will cause the program to insert a sequential number to the
message to make the file name unique.

HTML Template Button

The HTML Template  button will launch the HTML Setup window.  It can be used to create
html templates, select upload protocols and set your server options.

Execute External Program

The Exe Program field is used to start a third-party program when an alarm occurs.  Enter the full
path and program name for the third-party program.  Weather Message can pass the file name of
the message that caused the alarm.  To do this put one space after the program name and enter
the characters "$1".  For example, to start Notepad each time an alarm is triggered, enter
"Notepad.exe $1" in the Exe Program field.

Hint:  If the path to the executable contains a space, you should enclose the path and program
name in quotes.  For example:  "c:\program files\myprogram.exe" $1

Print Action

To print a text or graphic product to a printer setup on the computer running Weather Message
Server, select one of these print options.  Select No for no printing; Short for a short message;
Selected for selected text from the alarmed UGC group; Selected No Head for selected text
from the alarmed UGC group without the header; Full for Full Text; or Full No Head for Full Text
without header.
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2.6.5.1 Html Template

The Html Setup is used to select upload protocols and associate an optional html template for
merging weather text.

The Template File Name is the name of the html file that contains your template.  The Browse
button can be used to locate the template file.  The program automatically defaults to
..\WxMesgNet\WxData\Template for template files.  You can place templates in any directory.
The Template File Name is not required.  Leave this blank if you want to send the weather text
without html encoding.

If you have not established a template file, enter a name for a new template file.  This file will be
created, using the html code you specify when the Save button is clicked.

The Destination File Name is the name you want the resulting message to be named on your
server.  This field is required.  You can use variables in the path and file name, see Path / File
Name Variables

Select the Save To type, Local, FTP or HTTP.  If FTP or HTTP is selected, the program will allow
you to enter information about your FTP or HTTP server.  Enter the FTP Server address, Port
number, User Name and Password.  These settings will be used to log into your server.

The HTML Code box is used to enter the html code to encapsulate the weather text.  Remember
to use the variable $MESSAGE$ in this code as a place marker for your text.

The Save button will save your html template and update the Archive Path field.

Note:  If a html template is specified, the program will change any html reserved-characters in

52



Weather Message Server Setup 55

© 2007 Weather Message Software

the weather text to their corresponding html abbreviation.  This prevents html browsers from
misinterpreting the weather text as html code.

Note:  The http PUT command requires write access to the directory specified in the
command.

Note:  See Publishing Data to a Web Page for examples.

2.7 Print Settings

The Print Settings window allows you to print you print Alarms, Email Groups, Fax Groups, and
Pager Groups.

Select the items to print and click the Print button.
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3 Weather Message Server

3.1 Overview

Weather Message Server is the heart of the Weather Message applications.  When you start the
Weather Message Server, it runs from the system tray.  When it starts, it will automatically start
the ingest program(s) that you selected in Weather Message Setup.

Processing

The left pane contains the current processing information.  The last decoded message
information is displayed.  This file currently being processed is displayed in the Processing File
Name box.

The Files Processed box shows the number of alarms or messages that have been received
since the server was started.  The number to the right of the slash is the number of messages
that are queued for processing, but have not been processed.

The Message Clients box contains the number of connected message clients.  The Map Clients
box contains the number of connected map clients.

Note:  Weather Message currently allows for 50 client connections.  This can be increased to
100 or 250 by purchasing a 100 or 250-user license.

Note:  If Weather Message is stopped with the window minimized, the next time it is started, it
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will start minimized.

Note:  Weather Message will process files with the extensions txt, gif, jpg, zis, zip, bmp, png
and tif.  Other extensions will be handled as a regular text file.

Status

The right pane contains status messages from the subsystems.  Each subsystem displays status
messages as they process messages that meet your alarm criteria.

Hint:  The left and right pane can be resized by dragging the white separator line between the
panes.

System Tray

When Weather Message Server is minimized, you can restore the main screen by right clicking
on the system tray icon , then select open.

Special Keys

Pressing control-u while the main window has focus causes the program to start a file purge
cycle.

3.2 Menu Options

The menu buttons on this screen perform these functions:

The File menu allows you to setup the server, view connections, log files, show the active ingest
programs and exit the program.
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• The Setup option launches the Weather Message Server Setup  application.
• The View Connections option displays a window with the Active Connections .
• The View Logfile displays the server log file in notepad.
• The View Email Log displays the email log in notepad.
• The View Pager Log displays the pager log in notepad.
• The View Fax Log displays the fax log in notepad.
• The FTP Ingest option display a window to manually request a FTP file ingest .
• The Show Ingest option shows the main window of each ingest program running the

background.
• The Exit option shuts down Weather Message Server.

The Help menu allows you to see this manual, and display information about the program.

3.3 FTP Ingest

The FTP Ingest window is used to manually request a FTP ingest of weather products.  This
option requires an Internet connection. NOAA current offers text and image products for these
durations; fifteen minutes, one hour and three hours.

12
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The NOAA Server address is locked and can only be changed by modifying a registry value.
Select the file type and duration that you want to retrieve and click on the Retrieve button.

The Server's Archive / FTP status line is updated as the file is downloaded.

Note:  Since the one and three hour files can be quite large, it may take some time for them to
be retrieved and uncompressed.

Note:  On occasion, you may see a "permission denied" message when you attempt to
retrieve products.   This error message is returned by the NWS ftp server when it is updating
files.  If this occurs, wait a few minutes and try again.

3.4 Active Connections

The Active Connections window displays a list of clients connected to the server.

The Address column contains the TCP/IP address of the connected client.  The Computer
Name column contains the computer name.  The Socket column contains the internal socket
number associated with the client.  The Type column contains a C for message clients or a M for
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map clients.  The Id column contains the client's client identifier.  The Version column contains
the version number of the client software being used.  The Date column contains the date and
time that the client connected.

This window automatically updates every 15 seconds.  The Refresh button can be used to force
a refresh immediately.

3.5 Testing Alarms

In order to test your alarms, a message that matches your alarms must be received.  Included
with Weather Message is the application Weather Text Creator.  This application allows you to
create test messages.  See the section on WxMesgText Message Creator for specific program
operation.

3.6 Log Files

Weather Message creates a number of log files to record the operation of the software.  For
Weather Message Server, the main log file is named LogFile.txt.  This log file records alarms
activated for pagers, emails, faxes, clients, archives and print requests.  This file is located in the
WxMesgNet directory.  It also contains connection requests from clients and disconnect request
from clients.  You will also find any program error messages encountered, when processing
weather messages.

If you send messages to an email, paging or fax group, a log file is created for these operations.
Email activity is recorded in EmailLog.txt; pager activity is recorded in PagerLog.txt; fax activity is
recorded in FaxLog.txt.

The Weather Message Server Setup screen allows you to change the log file size.  The default
size is 50,000 bytes.  Once it reaches this limit, it is copied to the file LogFile.old and a new log
file is created.  This prevents your hard drive from filling up with large log files.  If you have the
Daily Logs option enabled, the log files are stored in the WxLogs directory.
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4 Third-party Applications

Weather Message can be setup to provide data for use by other third-party programs.  The ingest
programs have the ability to copy received files to multiple directories.  This ability allows third-
party programs to have their own dedicated ingest directory.

To setup the Weather Message Ingest programs for multiple directory support, see the section on
WxIngest, WxByte, WxWw2000, or WxPort.  The Paths tab in the ingest programs allows you to
specify additional distribution paths for third-party programs to pick up the arriving files.
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5 WxIngest - EMWIN Serial Ingest

5.1 Overview

WxIngest is used by Weather Message for serial port based EMWIN feeds.  These normally
originate from a satellite receiver or radio modem.  The ingest program can be started
automatically by the Weather Message Server or manually.

The main screen shows the status of incoming messages.  The Data Source field indicates
which source is being used to receive the EMWIN data.  Should the program stop receiving data,
it will display Data Alert to the right of the Data Source field.

The Processing File, Block and File Size fields show information about the received file.  A
green or red led appears to the right of the Processing File field.  This led will normally appear
green.  If any of the blocks received for this message are defective, the led will change to red.  To
monitor the received blocks, click on the green or red led.  The following image will appear over
the receive statistics.  Click the led again to toggle back to the statistics.

The Total Blocks field shows the total number of blocks received for a one-hour period, the Bad
Blocks field shows how many of the total blocks received were defective.  The bad blocks field is
a total of the Packet Length, Bad Header and Check Sum fields.  The Block Count field counts
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the number of messages that any blocks missing.

The Error Percent field shows the error percentage of the blocks received verses bad blocks.
You want this field as low as possible.  The background color of this field will change based on
the quality of the received data.  If the background is white, the received data has 10% or fewer
errors.  If the background is yellow, the received data has between 10% and 20% errors.  If the
background is red, the received data has an error rate greater than 20%.

If the received message is text, you will see the first 1024 characters of the message in the text
box.  This shows the text for the block just received, it does not show the complete message.

The ingest program will attempt to repair defective messages, if a duplicate message is received.

WxIngest supports a backup satellite system, retransmission receiver and/or backup by Internet,
using WxByte.  This option is enabled using Setup.

Note:  It is recommended that you run the ingest program on a computer that will not be used
for normal user programs.  The processing of serial data can be interrupted by other software
programs, which can result in lost weather products.

Note:  If WxIngest is stopped with the window minimized, the next time it is started, it will start
minimized.

Note:  While the program is using WxByte as a backup data source, the fields on the screen
may not be updated.  They will resume showing data when the main serial port begins to
receive data.

Note:  The program supports a second log file.  The second format uses a fixed field size for
easy analysis.  This log file is never purged and remains until the user deletes the log files.  To
enable this logging option, create the directory "NwsLogs" in the c:\program files\WxMesgNet
directory.

Note:  Some computers may detect your satellite receiver as a serial mouse.  This generally
occurs when the satellite receiver is turned on when booting the computer.  If this occurs, your
mouse will begin to move on it's own.  To correct this problem, turn off the satellite receiver.
Download the comdisable tool from Microsoft at this web address
http://support.microsoft.com/default.aspx?scid=kb;en-us;819036.

System Tray

When WxIngest is minimized, you can restore the main screen by right clicking on the system
tray icon , then select open.

Data Alert Notification

Should the program stop receiving serial data, you will see the following message appear above
the system tray icon.
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5.2 Menu Options

The menu buttons on this screen perform these functions:

The File menu allows you to setup this program, reset statistics, view logfiles, and exit the
program.

• The Setup option opens the Setup window .
• The Reset Stats option resets the application statistics.
• The View Logfile displays the ingest log file, WsLog.txt, in notepad.
• The View Files Received Log displays the received files log, WsFiles.txt, in notepad.
• The Exit option shuts down WxIngest.

Note:  In order to view the Files Received Log, the Log Received Files option must be
enabled.

The Port menu, when present, allows you to switch between the main serial port and a backup
serial port.

 The Help menu allows you to see this manual, and display information about the program.
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5.3 Setup

5.3.1 Settings Tab

The Settings Tab is used to define the communication port, backup options and other general
operations.

Primary Receiver

Select the Comm Port (communications port or serial port) for your satellite receiver, along with
the Baud Rate for that device.  For EMWIN satellite reception, select a baud rate of 9600,N,8,1.

Secondary Receiver / Backup Options

If you have a second satellite system or retransmission receiver, enter the Comm Port and Baud
Rate under the backup options.  Also, if you want to use WxByte (internet ingest) as a backup,
check that option.  The Switch Back Time is used to specify the number of minutes that the
program should check back to see if the main port is functioning, when using a second serial
port.

The Error Rate Greater field sets the error rate percentage for switch over to backup.  This field
can be set from 5 to 95 percent.  Should the error rate, of the received data, exceed the set
amount, the program will switch over to the backup port or WxByte.

If the main port stops sending data for 15 seconds, the program will switch to the backup port, if
one is specified.  If the backup port does not send data for 15 seconds, it will switch to WxByte, if
that option is selected.  If the backup port is not specified, it will switch from the main port directly
to WxByte, if that option is selected.
 
Based on the Switch Back Time specified, it will change back over to the main port.  The process
will start all over again.  If no data is received in 15 seconds, it will switch to the backup port
and/or WxByte. 
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Note:  Once WxByte is started, it will not be stopped until the program begins to receive valid
data from one of the serial ports.

When the program switches from serial ingest to WxByte, it will create a notification message in
each ingest directory.  The product identifier for this message is ADMWXM.  If you want to be
alerted when the program switches between ingest sources, alarm the product ADMWXM, with
no state or county selected.  The notification message contains the current ingest method and
computer name.

5.3.2 Common Tab

The Common Tab is used to define options common or shared by all ingest programs.

The Run in Background check box allows you to specify whether you want the ingest programs
to run in the background.  When this box is checked, the ingest programs will not show in the
system tray.  Once this option is enabled, you will not see the ingest programs running.  In order
to see the ingest screen, you will need to use the Show Ingest menu option in Weather Message
Server.

Note:  Changing this option does not take effect until the next time the ingest programs are
started.

The Log Received Files option causes the program to record the name of each weather file
received.  The names are recorded in WsFiles.txt.

The UnZip Received Files option, when checked, will cause the program to unzip any
compressed files.  This option is normally left unchecked as the Weather Message programs
automatically unzip compressed files.  In some applications it may be desirable to unzip the files
before they are copied to the ingest directory(s).

The Purge Ingest Directories option, when checked, will cause the program to automatically
purge the ingest directories after 24 hours.
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If you are running the Byte Blaster server, WxBBSrvr, check the Enable Byte Blaster Server
Support box.  This will cause the ingest program to create data records for processing by the
Byte Blaster server.

Note: This program communicates with WxBBSrvr using UDP port 9510 on the local loop back
address.

The Log File Size field allows you to specify this size of your ingest log file, WsLog.txt.  The
default is 50,000 bytes.

5.3.3 Ingest Paths Tab

The Ingest Paths Tab is used to define the directories that will store the received weather
products for processing.

The Ingest Path is defined in the Weather Message Server setup screen and would not normally
be entered here.

Note:  The Ingest Path can be changed if you want to deposit the received messages in a
directory other than the one established for Weather Message Server.

The Additional Distribution Paths can be used to place a copy of the received weather text in
different directories for processing by other programs.  For example, if you use Weather
Message to receive your weather data, you can put a copy of the received messages in a second
or third directory for processing by RealEMWIN or the Weather Message Retransmission
program.

Note:  Changing the Ingest and Additional Distribution Paths on this screen will automatically
change them for WxByte, WxPort, and WxWW2000.
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6 WxByte - EMWIN Internet Ingest

6.1 Overview

WxByte is used by Weather Message for Internet based EMWIN data feeds.  The ingest program
can be started automatically by the Weather Message Server or manually.

The main screen shows the status of incoming messages.

WxByte uses information from Internet weather servers to maintain a list of available servers.  It
attempts to connect to the first available server.  Should a server stop functioning, WxByte will
attempt to contact the next available server.  Every 10 minutes, WxByte receives an updated list
of servers.

WxByte uses TCP/IP port 1000 to communication with the servers.  If you have a firewall, port
1000 must be open for WxByte to work.

The Server field displays the TCP/IP address of the server providing EMWIN data.  The Connect
Time is the amount of time that you have been connected to this server.

The Processing File, Block and File Size fields show information about the received file.  A
green or red led appears to the right of the Processing File field.  This led will normally appear
green.  If any of the blocks received for this message are defective, the led will change to red.  To
monitor the received blocks, click on the Receiving label.  The following image will appear over
the receive statistics.  Click the Receiving label again to toggle back to the statistics.
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The Total Blocks field shows the total number of blocks received for a one-hour period, the Bad
Blocks field shows how many of the total blocks received were defective.  The bad blocks field is
a total of the Bad Header and Check Sum fields.  The Block Count field counts the number of
messages that any blocks missing.

The Error Percent field shows the error percentage of the blocks received verses bad blocks.

If the received message is text, you will see the first 1024 characters of the message in the text
box.  This shows the text for the block just received, it does not show the complete message.

The status information, included the decoded message display can be removed by clicking on
the up button or resizing the screen.  To show the status information and decoded message drag
down on the bottom of the window, or use the Show Details menu option.

Note:  If WxByte is stopped with the window minimized, the next time it is started, it will start
minimized.

Note:  The program supports a second log file.  The second format uses a fixed field size for
easy analysis.  This log file is never purged and remains until the user deletes the log files.  To
enable this logging option, create the directory "NwsLogs" in the c:\program files\WxMesgNet
directory.

System Tray

When WxByte is minimized, you can restore the main screen by right clicking on the system tray
icon , then select open.

Data Alert Notification

Should the program stop receiving data, you will see the following message appear above the
system tray icon.

Copyright © 2007 Weather Message Software

6.2 Menu Options
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The menu buttons on this screen perform these functions:

The File menu allows you to setup this program, show details, view logfiles, and exit the
program.

• The Setup option opens the Setup window .
• The Reset Stats option resets the application statistics.
• The View Logfile displays the ingest log file, WiLog.txt, in notepad.
• The View Files Received Log displays the received files log, WiFiles.txt, in notepad.
• The Exit option shuts down WxIngest.

Note:  In order to view the Files Received Log, the Log Received Files option must be
enabled.

 The Help menu allows you to see this manual, and display information about the program.

The WxByte Status window displays a list of Internet EMWIN Servers.  See Server Status .
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6.3 Setup

6.3.1 Settings Tab

The Settings Tab is used to define the communication port, backup options and other general
operations.

The Auto-Reconnect on Server Disconnect should be checked if you want WxByte to try to
connect to another server if it is disconnected from the current server.  The Auto-Update Server
List should be checked if you want WxByte to automatically maintain a list of available servers.  If
WxByte does not maintain this list, you will need to manually update the WxSvrus.txt file to
include the servers that you want it to use.

Note: This program communicates with WxBBSrvr using UDP port 9510 on the local loop back
address.

The Weather Wire Backup check box allows you to use Weather Wire as a backup for EMWIN.
Checking this box will cause the program to automatically start WxWW2000 when EMWIN data
is not available.  This requires registration for Weather Wire. See the Weather Wire help for
details.

When the program switches from WxByte to WxWW2000, it will create a notification message in
each ingest directory.  The product identifier for this message is ADMWXM.  If you want to be
alerted when the program switches between ingest sources, alarm the product ADMWXM, with
no state or county selected.  The notification message contains the current ingest method and
computer name.

A fixed TCP/IP server address can be used.  Enter the fixed TCP/IP address in the Enter Fixed
Address field.  Click on Use Fixed Address, to only connect to that specific server.  When you
use a fixed address, the Decrypt Data option is activated.  This option indicates whether you
want WxByte to decryption the received data.  This option should be checked when connecting to
a ByteBlaster Server.  Uncheck this option if you are connecting to the EMWIN software defined
receiver.
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The Timeout seconds on loss of data is set by default to 15 seconds.  You can change this
within the range of 15 to 600 seconds.

6.3.2 Common Tab

The Common Tab is used to define options common or shared by all ingest programs.

The Run in Background check box allows you to specify whether you want the ingest programs
to run in the background.  When this box is checked, the ingest programs will not show in the
system tray.  Once this option is enabled, you will not see the ingest programs running.  In order
to see the ingest screen, you will need to use the Show Ingest menu option in Weather Message
Server.

Note:  Changing this option does not take effect until the next time the ingest programs are
started.

The Log Received Files option causes the program to record the name of each weather file
received.  The names are recorded in WiFiles.txt.

The UnZip Received Files option, when checked, will cause the program to unzip any
compressed files.  This option is normally left unchecked as the Weather Message programs
automatically unzip compressed files.  In some applications it may be desirable to unzip the files
before they are copied to the ingest directory(s).

The Purge Ingest Directories option, when checked, will cause the program to automatically
purge the ingest directories after 24 hours.

If you are running the Byte Blaster server, WxBBSrvr, check the Enable Byte Blaster Server
Support box.  This will cause the ingest program to create data records for processing by the
Byte Blaster server.

Note: This program communicates with WxBBSrvr using UDP port 9510 on the local loop back
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address.

The Log File Size field allows you to specify this size of your ingest log file, WiLog.txt.  The
default is 50,000 bytes.

6.3.3 Ingest Paths Tab

The Ingest Paths Tab is used to define the directories that will store the received weather
products for processing.

The Ingest Path is defined in the Weather Message Server setup screen and would not normally
be entered here.

Note:  The Ingest Path can be changed if you want to deposit the received messages in a
directory other than the one established for Weather Message Server.

The Additional Distribution Paths can be used to place a copy of the received weather text in
different directories for processing by other programs.  For example, if you use Weather
Message to receive your weather data, you can put a copy of the received messages in a second
or third directory for processing by RealEMWIN or the Weather Message Retransmission
program.

Note:  Changing the Ingest and Additional Distribution Paths on this screen will automatically
change them for WxIngest, WxPort, and WxWW2000.

6.4 Server Status

The WxByte Status window display the status of the EMWIN Internet Servers.
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7 WxWw2000 - Weather Wire Ingest

7.1 Overview

WxWW2000 is used by Weather Message for Internet or serial port Weather Wire data feeds.
The ingest program can be started automatically by the Weather Message Server or manually.

The main screen shows the status of incoming messages.

The Data Source field shows type connection type; Internet or Serial Port.

The Received File and Last File fields display the product identifier of the current and last files
received along with the their respective received times.

Note:  Before WxWw2000 will connect to an Internet server you must enter your user name
and password in the setup screen.  For information on obtaining a user name and password,
see What is Weather Wire.

Note:  If you are using the Internet ingest option, the program will alternate the program icon in
the system tray to let you know that it is connected.

Note:  If WxWw2000 is stopped with the window minimized, the next time it is started, it will
start minimized.

System Tray

When WxWw2000 is minimized, you can restore the main screen by right clicking on the system
tray icon , then select open.

Copyright © 2007 Weather Message Software
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7.2 Menu Options

The menu buttons on this screen perform these functions:

The File menu allows you to setup this program, show details, view logfiles, and exit the
program.

• The Connect option starts a connection to the Internet servers.
• The Setup option opens the Setup window .
• The View Logfile displays the ingest log file in notepad.
• The View Files Received Log displays the received files log in notepad.
• The Exit option shuts down WxIngest.

Note:  In order to view the Files Received Log, the Log Received Files option must be
enabled.

The Source menu allows you to toggle between the Internet servers and serial port connection.

The Register menu allows you to register  WxWW2000.  This button does not appear if the
software is registered.  Note: If the software is not registered after 60 days, it will stop functioning.

 The Help menu allows you to see this manual, and display information about the program.
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7.3 Setup

7.3.1 Settings Tab

The Settings Tab is used to define the Internet settings, user name, password, communications
port and other general operations.

Select the Ingest Type; Serial Port or Internet.

For Internet ingesting, you must specify the Weather Wire URL, Weather Wire Port, User
Name and Password.  The program will provide defaults for the URL and port.  You will need to
enter the User Name and Password that you supplied to DynaCorp when you signed up for this
service.

For Serial Port ingesting, select the appropriate Comm Port and Baud Rate.

The Name by AWIPS option, when checked, causes the program to name the received files
using the AWIPS identifier found in the message, followed by the originating station's state
abbreviation.  When it is not checked, the received files are named using the first 3 characters of
the AWIPS identifier, followed by the originating station's 3 character abbreviation, followed by
the originating station's state abbreviation.

The Global Ingest Paths option controls whether WxWw2000 uses global ingest paths.  Global
ingest paths are shared between all of the ingest programs.  Unchecking this box will allow you to
define ingest paths that are different from the global ingest paths.

7.3.2 Common Tab

The Common Tab is used to define options common or shared by all ingest programs.
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The Run in Background check box allows you to specify whether you want the ingest programs
to run in the background.  When this box is checked, the ingest programs will not show in the
system tray.  Once this option is enabled, you will not see the ingest programs running.  In order
to see the ingest screen, you will need to use the Show Ingest menu option in Weather Message
Server.

Note:  Changing this option does not take effect until the next time the ingest programs are
started.

The Log Received Files option causes the program to record the name of each weather file
received.  The names are recorded in IBFiles.txt.

The Purge Ingest Directories option, when checked, will cause the program to automatically
purge the ingest directories after 24 hours.

The Log File Size field allows you to specify this size of your ingest log file, IBLog.txt.  The
default is 50,000 bytes.

7.3.3 Ingest Paths Tab

The Ingest Paths Tab is used to define the directories that will store the received weather
products for processing.
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The Ingest Path is defined in the Weather Message Server setup screen and would not normally
be entered here.

Note:  The Ingest Path can be changed if you want to deposit the received messages in a
directory other than the one established for Weather Message Server.

The Additional Distribution Paths can be used to place a copy of the received weather text in
different directories for processing by other programs.  For example, if you use Weather
Message to receive your weather data, you can put a copy of the received messages in a second
or third directory for processing by RealEMWIN or the Weather Message Retransmission
program.

Note:  Changing the Ingest and Additional Distribution Paths on this screen will automatically
change them for WxByte, WxIngest, and WxPort.

7.4 Register Software

The Register menu option allows you to register your software.
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When you purchase WxWw2000, you will be supplied with a Registration Name and
Registration Code.  Enter these exactly as they are printed.  These fields are case sensitive.

After the software is registered, we recommend that you stop and restart the software.

To purchase the software go to http://www.wxmesg.com/purchpay.htm.
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8 WxPort - NOAAPort Ingest

8.1 Overview

WxPort is used by Weather Message to receive NOAAPort data.  WxPort can process one
TCP/IP multicast port from the NOAAPort data stream.  The ingest program can be started
automatically by the Weather Message Server or manually.

The main screen shows the status of incoming messages.

The Data Source field displays the multicast port used to receive NOAAPort data.

The Sequence field displays the last sequence number received.

The Received File and Last File fields displays the current and last file received.

Note:  If WxPort is stopped with the window minimized, the next time it is started, it will start
minimized.

System Tray

When WxPort is minimized, you can restore the main screen by right clicking on the system tray
icon , then select open.

Copyright © 2007 Weather Message Software
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8.2 Menu Options

The menu buttons on this screen perform these functions:

The File menu allows you to setup this program, view logfiles, and exit the program.

• The Setup option opens the Setup window .
• The View Logfile displays the ingest log file in notepad.
• The View Files Received Log displays the received files log in notepad.
• The Exit option shuts down WxPort.

Note:  In order to view the Files Received Log, the Log Received Files option must be
enabled.

The Register menu allows you to register  the WxPort software.  This button does not appear
if the software is registered.  Note: If the software is not registered after 60 days, it will stop
functioning.

 The Help menu allows you to see this manual, and display information about the program.

8.3 Setup

8.3.1 Settings Tab

The Settings Tab is used to define the communication port, backup options and other general
operations.
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The Interface Address is the TCP/IP address of the network device that will be providing the
multicast packets.

The Multicast Address is the address of the NOAAPort data channel that you want to decode.
The Multicast Port must be specified along with this address.  Here is the breakdown of the
Multicast addresses and ports:

Channel Address Port
NWSTG 224.0.1.1 1201
GOES 224.0.1.2 1202
NWSTG2 224.0.1.3 1203
OCONUS 224.0.1.4 1204

The Global Ingest Paths option controls whether WxPort uses global ingest paths.  Global
ingest paths are shared between all of the ingest programs.  Unchecking this box will allow you to
define ingest paths that are different from the global ingest paths.

The Drop Binary Files check box allows you to specify whether WxPort should process
messages that contain binary data.  If you do not want the messages with binary data, check this
box and they will not be processed.

8.3.2 Common Tab

The Common Tab is used to define options common or shared by all ingest programs.
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The Run in Background check box allows you to specify whether you want the ingest programs
to run in the background.  When this box is checked, the ingest programs will not show in the
system tray.  Once this option is enabled, you will not see the ingest programs running.  In order
to see the ingest screen, you will need to use the Show Ingest menu option in Weather Message
Server.

Note:  Changing this option does not take effect until the next time the ingest programs are
started.

The Log Received Files option causes the program to record the name of each weather file
received.  The names are recorded in IBFiles.txt.

The Purge Ingest Directories option, when checked, will cause the program to automatically
purge the ingest directories after 24 hours.

The Log File Size field allows you to specify this size of your ingest log file, IBLog.txt.  The
default is 50,000 bytes.

8.3.3 Ingest Paths Tab

The Ingest Paths Tab is used to define the directories that will store the received weather
products for processing.
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The Ingest Path is defined in the Weather Message Server setup screen and would not normally
be entered here.

Note:  The Ingest Path can be changed if you want to deposit the received messages in a
directory other than the one established for Weather Message Server.

The Additional Distribution Paths can be used to place a copy of the received weather text in
different directories for processing by other programs.  For example, if you use Weather
Message to receive your weather data, you can put a copy of the received messages in a second
or third directory for processing by RealEMWIN or the Weather Message Retransmission
program.

Note:  Changing the Ingest and Additional Distribution Paths on this screen will automatically
change them for WxByte, WxIngest, and WxWW2000.

8.4 Register Software

The Register menu option allows you to register your software.
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When you purchase WxPort, you will be supplied with a Registration Name and Registration
Code.  Enter these exactly as they are printed.  These fields are case sensitive.

After the software is registered, we recommend that you stop and restart the software.

To purchase the software go to http://www.wxmesg.com/purchpay.htm.
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9 Message Client

9.1 Overview

The Weather Message Message Client, WxMcli, is used to receive processed text and graphic
products from Weather Message Server.  The Message Client can be installed on any computer
attached to a TCP/IP network.  Based on your alarms and settings, the Message Client can
popup a window and play different sounds.

The Message Client should be automatically started when your computer is started.  The
Message Client runs from the system tray.

Hint:  If the Password for Setup/Exit option has been enabled, this program cannot be
terminated with the X button, without a password.  This feature insures that the user does not
accidentally stop weather alerts.

Hint:  If the system tray icon is outlined with a red circle or a red led appears in the status bar,
the program is not communicating with the Weather Message Server.

Note:  The Silence button to the right of message description only appears when a one-minute
or continuous sound plays.  It disappears when the sound finishes or Silence is clicked.

Note:  If WxMcli is stopped with the window minimized, the next time it is started, it will start
minimized.

System Tray

When WxMcli is minimized, you can restore the main screen by right clicking on the system tray
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icon , then select open.

Copyright © 2007 Weather Message Software

9.2 Menu Options

The menu buttons on this screen perform these functions:

The File menu allows you to setup this program, show details, view logfiles, and exit the
program.

• The Setup option opens the Setup Window .
• The Printer option selects the default printer and font size.
• The Connect option forces the application to attempt a connection to the server.
• The Exit option shuts down the Message Client.

Note:  If you enable the Password for Setup/Exit, you will have to enter the a password to
access the setup screen or exit the program.

The Silence menu option allows you to stop a sound that is playing.

The Text menu allows you to clear the main window and search for a word or phrase.

The Request menu allows you to request a specific product or a list of products.
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• See Request Product .
• See Request Product List .

The Quick List menu allows you to quickly request predefined products.

• See Quick List  setup tab.

The Product List menu option opens the floating product list.

The Image Viewer menu allows you to select from 1 to 10 image viewers.  The menu shows the
last image viewed with each viewer.

• See Image Viewer .

The Help menu allows you to see this manual, and display information about the program.
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9.3 Main Window

The Messages Tab displays a scrolling text box of received weather products.  The last message
received is at the top.  The size of the scrolling buffer can be change in Setup .  To view an
incoming message in a separate window, click on the message and a new window will open.

The status bar at the bottom of the window display connection information.  Normally you will see
a green led, which indicates you are connected to Weather Message Server.  If the program is
not connected, you will see a red led and the system tray icon will show a red circle.
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The Alarms Tab contains a list of active alarms.  It displays the message description, counties,
and expiration information.  When an alarm is received, the system tray icon changes to the color
red, until all alarms have expired.  When alarms expire, the time remaining field changes to
"expired".  Expired items remain in this list for 15 minutes.

Click on a row in the list to read the message that caused the alarm.

9.4 Product List

The Message Client features a floating received products window.  You can minimize the main
window and keep this small window open to monitor received products.  You can click on any of
the received products to see the text or image associated with the product name.

To see a list of products received with the same product identifier, hold down the shift key before
clicking on the received product.

Note:  For products to appear in this list, an alarm must be established in Weather Message
Server.
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The default product list has several options.  To see a list of options, right click to see this menu.

The default option is to show all products in a single list.  If you only want to see text products in
your list, click the Text Only option.  To only want to see graphic products, click the Graphic
Only option.

The Wild Card option allows you filter the list using a wildcard.  Enter a wildcard expression in
the menu text box, then click on the Wild Card option.

The Split List option changes the standard product list into two lists.  The top list contains text
products and the bottom list the graphic products.
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The Refresh List option sends a request to the server to refresh the text product received during
the last two hours.  The graphic products are refreshed from the clients local cache.

The Clear List option clears the received products list.

Note:  When you shutdown Message Client, the application will store the items in the product
list.  The next time you start Message Client, the product list will be populated with the items it
contained the last time it was shutdown.

9.5 Request Product

The Request Product window allows you to request a product by identifier.
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The product codes are composed of a 3-character weather product code and either a 2-character
state or forecast office code.  See Weather Forecast Offices for a list of the forecast office codes.
See Text Product Abbreviations for a list of weather product codes.   For example a special
weather statement for Birmingham, Alabama is coded SPSBMX.  This code can be entered in
the Product Code field to get the last special weather statement issued.

The Product Code field also contains a list of the last 20 products received.  To view and/or
select an item from this list, click on the down arrow in the Product Code field.

The E-Mail Message button opens your email application and inserts the message text in the
body of the message.

The Print Message button prints the message text to your default printer.

The Close button closes this window.

9.6 Request Product List

The Request File List window allows you to request a list of products by identifier.
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The product codes are composed of a 3-character weather product code and either a 2-character
state or forecast office code.   See Weather Forecast Offices for a list of the forecast office
codes.  See Text Product Abbreviations for a list of weather product codes.   For example a
special weather statement for Birmingham, Alabama is coded SPSBMX.  This code can be
entered in the request field to get a list of the special weather statements for Birmingham
currently stored in Weather Message.

To view one of the listed messages, click on the message identifier in the product column.
Clicking on the expiration date column will sort the list in ascending or descending order.

9.7 Setup

9.7.1 Server Tab

The Server Tab is used to define the communications information to Weather Message Server.
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The Host TCP/IP Address is the address of the Weather Message Server.  Enter the address of
your primary server in this field.   The default is 127.0.0.1 for the local computer.

The Host TCP/IP Port is the port defined by Weather Message Server for connections.  The
default is 9501.

The Backup Address is the TCP/IP address of your backup Weather Message Server.  Do not
enter an address in this field if you do not have a backup Weather Message Server.  This
address is used when the program cannot contact your primary Weather Message Server.

The Backup Port is the port defined for use by the backup Weather Message Server.  The
default is 9501.

The Client Identifier field allows you to assign each Message Client a different identification
number.  This identifier can be used to send a specific alarm to a specific client or group of
clients.

9.7.2 Settings Tab

The Settings Tab is used to set operational information for the Message Client.
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The Password for Setup/Exit option allows you to require a password to access the Setup
menu or exit the program.

The Enable Popup Selection, when checked, will give the user the capability to enable or
disable the applications popup operation.  The Enable/Disable option will appear on the system
tray menu.

The Product List On Top field causes the product list, when shown, to appear on top of all other
windows.

The Receive Graphics field should be checked, if you want to receive weather graphics.

Note:  Weather Message Server would also have to be setup to send graphic files.

The Graphics Purge Time field defines the amount of time, in hours, to retain graphic images.
After an image exceeds this time, it is deleted.

The Start Up Wave File allows you to specify a wave file to play when the program is started.
Use the Browse button to locate a wave file.  If you do not want a wave file to play at startup,
enter None in this field.  To hear the wave file, click Play.

The Scroll Buffer Size defines the number of characters to keep in the main text window.

The Product List Opacity allows you to setting the opacity or transparency of the product list.
100 represents a normal window.  The lower the value the more transparent the product list
becomes.  This allows you to see through the product list when it is positioned on top of other
windows.

The Product List Size allows you to determine the number of products that are contained in the
product list.
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9.7.3 Alarms Tab

The Alarms Tab is used to set sounds, colors, print and popup options for 20 alarms.

The Weather Message Server Setup program allows you to associate an Alarm Type for each
alarm that is sent to the Message Client.  This Alarm Type causes the Message Client to play a
wave file and pop-up a minimized screen, based on your settings.  In addition, it uses the color
associated with the alarm type to display the message description on the status line and in the
Product List window.

Message Client supports up to 20 different alarm types.  To select a specific alarm type, click on
the up or down buttons adjacent to the Type # field.  Click on the Browse button to select a wave
file.  Each wave file can be played, Once, for 1 minute, or Continuous. To hear the sound
associated with the alarm, click the Play Wave File button. Alarms can be silenced, by clicking
on the Silence button.  The number of the alarm to be played is determined when the Alarm is
established in Weather Message Server Setup.

The Product to Wave option is used when you want a specific sound to be played based on the
product identifier.  When using this option, you will create a wave file that has the same name as
the product identifier.  This wave file should be saved in the "Sounds" directory located in the
WxMesgNet directory.

When this option is enabled, the program will look for a wave file in the "Sounds" directory that is
named like the product being received.  It will first look for the complete 6 character product
identifier and play that file.  If the 6 character product identifier is not found, it will look for a file
with the first 3 characters of the product identifier and play that file.  If neither are found, it will
play the default wave file associated with this alarm.

Here are some examples of using the Product to Wave option.  The following files are stored in
the "Sounds" directory; "TORBHM.wav", "TOR.wav".  With the Product to Wave enabled for
Alarm Type 1, the program will look at each received product associated with Alarm Type 1.  If
the incoming message contains the product identifier "TORBHM", the program will play the file
"TORBHM.wav".  If it receives "TORHUN", it will play the file "TOR.wav" since it cannot locate a
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file labeled "TORHUN.wav".

The Print option, if checked, will print out the received weather product to your default printer.

The Execute Program option allows you to start a third-party program when an alarm occurs.
Enter the full path and program name for the third-party program. The Message Client can create
a temporary file with the text so that it can be passed to the external program as a command line
argument.  To do this, put one space after the program name and enter the characters "$1". For
example, to start Notepad each time an alarm is triggered, enter "Notepad.exe $1" in the Execute
Program field.

Hint:  If the path to the executable contains a space, you should enclose the path and program
name in quotes.  For example:  "c:\program files\myprogram.exe" $1

The Color button, allows you to select a foreground and background color for the weather
product description.  Left click to change the background color.  Right click to change the
foreground color.

The Pop Up Client option specifies whether Message Client pops up a minimized window when
this alarm arrives.

The Client On Top setting can be used to make the Message Client window the window that
appears on top of all other windows.  If you use this option, an alarm will cause Message Client
to appear on top of all other running programs.

9.7.4 Product Colors Tab

The Product Colors Tab is used to .

The Product ID column contains the first three letters of the AWIPS identifier to be colored.  To
add a new product identifier, scroll down to a blank cell and click in the cell.  Enter the product
identifier and press enter.  Then right click in color column to change the foreground (text) color
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or left click to change the background color.

The colors associated with the alarms, established under the Alarms tab, will override these
default colors.

9.7.5 Quick List Tab

The Quick List Tab is used to .

To add a category, enter the category description and click Add.  To change a category, click on
the category, make any changes and click on Change.  To delete a category, click on the
category and press the keyboard delete key or the Delete button.

To add a category item, first select the category.  Enter the category item description and product
description then click Add.   To change a category item, first select the category, then the
category item.  Make any changes and click on Change.  To delete a category item, first select
the category, then the category item and press the keyboard delete key or click the Delete
button.

Hint:  If you suffix the product name with "*", the program will display a list of products, instead
of the last product received.  The default option of the quick list is similar to the Request
Product option.  When the product name contains an "*", it operates similar to the Request List
option.
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10 Image Viewer

10.1 Overview

The Image Viewer allows you to view received weather graphics and locally processed radar
images.  The Image Viewer is started by clicking on the Image Viewer menu option in Message
Client and selecting one of the 10 viewers.

Each Image Viewer instance (1 to 10) remembers the last image you viewed, along with the size
of the viewer window and the last position of the scroll bars.  When you access that viewer again,
it will automatically display the last image viewed.

10.2 Menu Options
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The File menu allows you to save the displayed image, print the image, setup this program,
retrieve previously viewed images, and exit the program.

• The Save Image option is used to save the currently displayed image.  Images can be
saved in GIF, JPG, PNG, TIF and BMP format.

• The Print Full Image option will print the entire image to your default printer.
• The Print Displayed Image option will print the image visible in the Image Viewer window

to your default printer.
• The Setup option opens the Setup Window .
• Items 1 through 4 act as a recent image viewed list.  Select a previously viewed image to

see it again.
• The Exit option shuts down the Message Client.

Note:  If you enable the Password for Setup/Exit, you will have to enter the a password to
access the setup screen or exit the program.

The Select Image menu launches the Select Image  window.

The Browse menu launches the Image Browser . It is used to see a thumbnail of the images
recently received.

The Image menu allows you to alter the sizing and resizing behavior of the displayed image.
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• The Fit to Window option, when checked, will cause the displayed image to fit the size of
the image viewer.

• The Keep Aspect Ratio, when checked, will cause the viewer to retain the aspect ratio of
the displayed imaging.  Urn-checking this option can cause the image to be distorted.

The Animate menu will start an animation of images.  The button only appears if more than one
image is available for animation.

• The Start option or F8 function key starts the animation.
• The Stop option or F9  function key stops the animation.
• The Increase Speed option or F11 function key increases the animation speed.
• The Decrease Speed option or F12 function key decreases the animation speed.

The Help menu allows you to see this manual.

10.3 Image Options

The displayed image can automatically be resize by selecting on of the Image  menu options.68
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There are also a number of zoom options available by right clicking on the image.  Right click on
the image to see this menu.

The default view is Zoom 100%.

10.4 Selecting Images

Images are selected by either clicking on a graphics product in the Product List, selecting a
recently viewed image from the File menu, browsing for an image using the Image Browser or
using the Select Image window.
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Images are broken down into six categories.  Click on one of the categories to see a list of
images available.  When an image is selected, the program will display the image, if it is
available.  If the Auto Animate option is enabled, the image will automatically begin animation.

The Miscellaneous category contains a slide show option.  This can be used with the animate
option to show all images.

10.5 Image Browser

The Image Browser allows you to browser received images.

Click on a image to load it into the Image Viewer.
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Note:  If you have received a large number of images, it make take several seconds for this
screen to populate.

10.6 Setup

10.6.1 Program Tab

The Program Tab is used to set the graphics directory and other program defaults.

The Graphics Directory is automatically setup by the system.  This directory should not have to
be changed under normal situations.

The Auto Animate option, when checked, will make the program automatically start image
animation when an image is selected.

The Default Zoom field allows you to specify the zoom factor that is used when the image viewer
is initially loaded.

Note:  If you are running the Message Client on the same computer as Weather Message
Server, the graphic products will be stored in two different directories.  One directory is used
for the Server and another for the Message Client.  You can eliminate the double storage on
the server by disabling the "Receive Graphics" option on the message client.  Then change the
graphic directory path on the Image Viewer to the Servers graphic directory.  This should not
be an issue for most users, unless disk space is limited.

10.6.2 Images Tab

The Images Tab is used to
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To add a category, enter the category description and click Add.  To change a category, click on
the category, make any changes and click on Change.  To delete a category, click on the
category and press the keyboard delete key or click on the Delete button.

To add a category item, first select the category.  Enter the category item description, file name
and count (images to animate), then click Add.   To change a category item, first select the
category, then the category item.  Make any changes and click on Change.  To delete a category
item, first select the category, then the category item and press the keyboard delete key or click
on the Delete button.

Note: The program will not allow you to enter a duplicate file name.
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11 WxMap Client

11.1 Overview

The Weather Message Mapping application, WxMap, is used to visually plot received weather
products from Weather Message Server on a graphical map.  WxMap uses GIS technology to
allow you to view any part of the United States map and its possessions.  WxMap can be
installed on any computer attached to a TCP/IP network.  Based on your alarms and settings,
WxMap can popup a window and play different sounds.

WxMap should be automatically started when your computer is started.  WxMap runs from the
system tray.

The map included with the default installation does not show interstate roads.  To add this
capability, download and install the optional map layers from your CD or the Weather Message
downloads page.

Hint:  If the Password for Setup/Exit option has been enabled, this program cannot be
terminated with the X button, without a password.  This feature insures that the user does not
accidentally stop weather alerts.

Hint:  If the system tray icon is outlined with a red circle or a red led appears in the status bar,



WxMap Client 123

© 2007 Weather Message Software

the program is not communicating with the Weather Message Server.

Note:  If WxMap is stopped with the window minimized, the next time it is started, it will start
minimized.

System Tray

When WxMap is minimized, you can restore the main screen by right clicking on the system tray
icon , then select open.

Copyright © 2007 Weather Message Software

11.2 Menu Options

The menu buttons on this screen perform these functions:

The File menu allows you to setup this program, show details, view logfiles, and exit the
program.

• The Setup option opens the Setup Window .
• The Printer option selects the default printer and font size.
• The Map Landmarks option opens the Landmarks Window.
• The Connect option forces the application to attempt a connection to the server.
• The Refresh Map option clears the map of any active alarms and sends a refresh request

106



Weather Message Server124

© 2007 Weather Message Software

to Weather Message Server.
• The Print options prints an image of the map window.
• The Exit option shuts down the Message Client.

Note:  If you enable the Password for Setup/Exit, you will have to enter the a password to
access the setup screen or exit the program.

The Silence menu option allows you to stop a sound that is playing.

The Map menu allows you to make adjustments to the displayed map and see the active alarms.

• The Zoom In option or F11 function key zooms in the map.
• The Zoom Out option or F12 function key zooms out the map.
• The Select Mode is the default mode.  This mode allows you to click on counties to see

active weather products.
• The Drag Mode changes the cursor to a hand and allows you to drag the map.
• The Zoom Mode changes the cursor to a hand with a pointing finger.  This allows you to

draw a box around an area and zoom in the drawn area.
• The Lock Map option, when checked, locks the map.  When locked, the map cannot be

zoomed, or moved.
• The Reset Map option, resizes the map showing all of the United States.
• The Active Alarms option displays the Active Alarms  window.

Note:  If you are in the drag or zoom mode, you will not be able to click on a county to see the
county's information.

The Views menu allows you to quickly change and save the map view to one of four user defined
areas.

130
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• See Views .

The Save Image option saves the current map image to ..\WxMesgNet\MapImage.jpg.

The Help menu allows you to see this manual, and display information about the program.

11.3 Main Window

You can click in the map legend, on any of the weather type buttons, to see a list of active
warnings or watches for that weather type.  You can also identify a county's name and current
alarms by moving the mouse pointer over the county and pausing.  After a short pause, the
county name and state will appear, along with a list of active alarms.

Left Click once on a county and a window will be displayed showing the actual weather text

129
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that caused the alarm.  If more than one alarm is active, you will see each message associated
with the active alarms.

Note:  Received warnings and watches color the map based on the map legend priority.  The
first item in the legend, Tornado Warning, has the highest priority.  To change the priority, see
the Setup section.

Note:  In order for weather products to be displayed on the map, they must be setup in
Weather Message server.  WxMap recognizes these products: TOR, FFW, SVR, WSW, SLS,
WOU and FFA.  Other products can be sent to WxMap and associated with a color, see the
setup section for more information.

To assist you with identifying counties that have been recently placed under a watch or warning,
the application will draw a highlighted line around the county.  This line will remain for 5 minutes.
When there are many counties under watches or warnings, you will be able to easily see which
ones were just placed under a watch or warning.

The application will also draw a dark blue line around counties that have alarms which are about
to expire.  Five minutes before the alarm is to expire, the program will outline the county.  This
will assist you with identifying counties that have alarms about to expire.

Special Keys

Pressing control-s while the main window has focus causes the program to save the map image
using the information setup for images.

11.4 Map Legend

The Map Legend buttons allow you to quickly get a list of counties included in a specific weather
type.
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Click on one of the weather type buttons to see the active counties.

This window displays the county name and state, along with the expiration date and time.  Click
on a county name to read the weather text associated with the county.

11.5 County Information

Left Clicking on a county displays a window showing the messages associated with the current
alarms.



Weather Message Server128

© 2007 Weather Message Software

The E-Mail Message button opens your email application and inserts the message text in the
body of the message.

The Print Message button prints the message text to your default printer.

The Close button closes this window.

Right Clicking on a county displays this menu.

Select Show County Information to display National Weather Service information about the
county.

Hint:  This screen can help you identify the Forecast Office assigned to your county.
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The Show Notes option opens a window that allow you to record information about that
county.

The Print Notes button prints the displayed notes to your default printer.  Click Save to save
any changes and Close to close this window.

Note:  The notes for each county are stored in the ..\WxMesgNet\Map\Notes directory.
They are stored as rich text (RTF) files and can be edited with any RTF editor.  Fonts and
colors can be included when using an external editor.

The Label County Toggle On/Off, when On for a county, causes the county's name to be
displayed on the map.

11.6 Views

The Views Menu option allows you to preset different map views.  This capability allows you to
establish 4 different views to quickly reposition the map to the defined areas.

To preset one of the four views, position the map for the area to be included in the view.  Click on
one of the Save View items.  You will be prompted to enter a name for this view.
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The name you entered will now be displayed in the View menu.

11.7 Active Alarms

The Active Alarms Menu option allows you to view the current alarms.

The alarm grid display information about each active alarm.  The colums and rows can be
expanded to show hidden information.  The columns and rows can be extended by clicking a row
or column line and dragging the line.  You can also sort the information by clicking on the column
identifier.

Right click an entry to expire a product or click the Expire All button to expire all active alarms.

The Refresh button will refresh the alarm grid.

Note:  The alarm grid will automatically refresh every 30 seconds.

11.8 Setup

11.8.1 Server Tab

The Server Tab is used to define the communications information to Weather Message Server.
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The Host TCP/IP Address is the address of the Weather Message Server.  Enter the address of
your primary server in this field.   The default is 127.0.0.1 for the local computer.

The Host TCP/IP Port is the port defined by Weather Message Server for connections.  The
default is 9501.

The Backup Address is the TCP/IP address of your backup Weather Message Server.  Do not
enter an address in this field if you do not have a backup Weather Message Server.  This
address is used when the program cannot contact your primary Weather Message Server.

The Backup Port is the port defined for use by the backup Weather Message Server.  The
default is 9501.

The Client Identifier field allows you to assign each Message Client a different identification
number.  This identifier can be used to send a specific alarm to a specific client or group of
clients.

11.8.2 Settings Tab

The Settings Tab is used to operational information for WxMap.
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The Password for Setup/Exit option allows you to require a password to access the Setup
menu or exit the program.

The Enable Popup Selection, when checked, will give the user the capability to enable or
disable the applications popup operation.  The Enable/Disable option will appear on the system
tray menu.

The Show Lat/Long, when checked, displays the latitude and longitude for the mouse cursor in
the status bar.

The Status Message Style allows you to select the color scheme used for the status message
box.  The status message shows new alarms as they are received.  You can select whether to
show these messages in the color of the type of alarm that is being received.  Messages not
related to arriving alarms are displayed with a white background and black text. The Status
Message Style can be set to Default – background is white, text is black; Map Color –
background is text color, text is map color; or Text Color – background is map color, text is text
color.

The Pop Up Style allows you to determine how WxMap window reacts to arriving alarms.  The
settings are All, All On Top, Alarms and Never.  The All setting causes WxMap to popup the main
window if it minimized.  The All On Top setting causes WxMap to popup the main window if it is
minimized and makes the WxMap window the window that appears on top of all other open
windows.  If you use this option, any alarm will cause WxMap to appear on top of all other
running programs and be the active program.   The Alarms setting uses the popup and on top
option on the Alarm tab to determine when the main window should be displayed.  The Never
setting causes WxMap to not popup a minimized window when an alarm arrives.

11.8.3 Alarm Colors Tab

The Alarm Colors Tab is used to set the priority and colors for weather types displayed in the
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map legend.

The order of warning and watch products can be changed.  To rearrange the products, use the
down arrow next to each item to select a different product order.

To change a background color, left click on the Color button you want to change.  To change the
text color, right click on the Color button.

Products sent to WxMap, with no associated color, will be colored in the Default Product Color.
See the Other Colors Tab  to establish colors for other products.

11.8.4 Alarms Tab

The Alarms Tab is used to set sounds, colors, print and popup options for 20 alarms.

135



Weather Message Server134

© 2007 Weather Message Software

The Weather Message Server Setup program allows you to associate an Alarm Type for each
alarm that is sent to the Message Client.  This Alarm Type causes WxMap to play a wave file
and pop-up a minimized screen, based on your settings.

Note:  The Message Client and WxMap use the same alarm type.

WxMap supports up to 20 different alarm types.  To select a specific alarm type, click on the up
or down buttons adjacent to the Type # field.  Click on the Browse button to select a wave file.
Each wave file can be played, Once, for 1 minute, or Continuous. To hear the sound
associated with the alarm, click the Play Wave File button. Alarms can be silenced, by clicking
on the Silence button.  The number of the alarm to be played is determined when the Alarm is
established in Weather Message Server Setup.

The Product to Wave option is used when you want a specific sound to be played based on the
product identifier.  When using this option, you will create a wave file that has the same name as
the product identifier.  This wave file should be saved in the "Sounds" directory located in the
WxMesgNet directory.

When this option is enabled, the program will look for a wave file in the "Sounds" directory that is
named like the product being received.  It will first look for the complete 6 character product
identifier and play that file.  If the 6 character product identifier is not found, it will look for a file
with the first 3 characters of the product identifier and play that file.  If neither are found, it will
play the default wave file associated with this alarm.

Here are some examples of using the Product to Wave option.  The following files are stored in
the "Sounds" directory; "TORBHM.wav", "TOR.wav".  With the Product to Wave enabled for
Alarm Type 1, the program will look at each received product associated with Alarm Type 1.  If
the incoming message contains the product identifier "TORBHM", the program will play the file
"TORBHM.wav".  If it receives "TORHUN", it will play the file "TOR.wav" since it cannot locate a
file labeled "TORHUN.wav".

The Pop Up Map option specifies whether WxMap pops up a minimized window when this alarm
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arrives. The Map On Top setting can be used to make the WxMap window the window that
appears on top of all other windows.  If you use this option, an alarm will cause WxMap to appear
on top of all other running programs.

11.8.5 Other Colors Tab

The Other Colors Tab is used to establish colors for products not listed in the map legend.

The Product / VTEC column contains the first three letters of the AWIPS identifier or a two letter
VTEC phenomena followed by a one-letter significance to be colored.  To add a new product
identifier or VTEC code, scroll down to a blank cell and click in the cell.  Enter the product
identifier and press enter.   Then right click in color column to change the foreground (text) color
or left click to change the background color.

The order of products in this list controls the priority.  Items at the top of the list have a higher
priority than products at the bottom of the list.  The change the order, select a product and use
the up and down arrows to the right of the color column.

To view a list of VTEC phenomena and significances, click on the Show Vtec Codes button.
Using the VTEC phenomena and significance codes allows you to color the many different
phenomena contained in WSW (winter weather) and NPW (non-precipitation) messages.

The New Alarm Outline color specifies the border color for new products.  Click on the Color
button to change this color.

The Expiring Alarm Outline color specifies the border color for expiring products.  Click on the
Color button to change this color.
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11.8.6 Map Base Tab

The Map Base Tab is used to set colors and options for the base map.

The Viewer Color button allows you to change the color of the areas outside of the map.  This is
normally the color of the oceans.

The Outline Color button allows you to change the outline color of the counties.

The Line Size field specifies the size of the line used to draw the county outline.

The Background Color button allows you to change the background of the counties.

The Transparency field allows you to control how the layer is painted over the viewer.  One
hundred ("100") is a completely transparent background, while zero ("0") is no transparent
background.

11.8.7 Map Layers Tab

The Map Layers Tab is used to setup additional map layers.
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The default installation includes the state map layer.  This layer is used to outline the states.  The
Weather Message website has an optional map layer download that contains interstate roads.  T

The File Name field contains the name of the map layer.

The Line Size field specifies the size of the lines in the layer.

The Transparency field allows you to control how the layer is painted over the county map layer.
One hundred ("100") is a completely transparent background, while zero ("0") is no transparent
background.

Hint: The optional map layers must be located in the ..\WxMesgNet\Maps directory.

11.8.8 Image Options Tab

The Image Options Tab is used to
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The Save Map on Change option will cause the program to save an image of the map each time
it changes.

The Map Save Interval field sets the amount of time in minutes that the program will
automatically save the map image, when the Save Map on Change option is enabled.  You can
set this interval to zero.  When it is set to zero, the program will only save the map when it
changes.

The Interval Always Active causes the program to save the map image, at the specified
interval, even if there are no active watch/warnings.  When this option is unchecked, the program
will only save the map image when there is a change or active watch/warnings.

The Image Type field allows you to select the format of the saved image.  Select JPG, PNG,
BMP or TIF.

The Image Quality field allows you to specify the quality of the saved image.  For JPG images,
zero ("0") represents the lowest quality, while one hundred ("100") represents the highest quality.
For PNG images, zero ("0") represents no compression, while one hundred ("100") represents
full compression.  You can enter a number in the range of zero to one hundred.

The Map Image Path is the local or server directory where the map image should be stored.
The application will automatically add the name, "MapImage.xxx", when it saves the image.

Select the Save To type, Local, FTP or HTTP.  If FTP or HTTP is selected, the program will allow
you to enter information about your FTP or HTTP server.  Enter the FTP Server address, Port
number, User Name and Password.  These settings will be used to log into your server.
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11.9 Map Landmarks
Enter topic text here.

11.9.1 Overview

You can setup landmarks to be displayed on the map.  These landmarks can be a simple point, a
name, or the current date and time.

To add, change or delete a landmark, click on the line that you want to modify and right click,
then select the appropriate function, Add, Edit or Delete.

When adding or editing a landmark, the Edit Landmark  window is displayed.

11.9.2 Landmark
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Enter the Latitude and Longitude for the landmark.  This coordinate will be the center position
for the landmark.  The Map Text field contains the text to be displayed on the map.  This field
supports two special codes.  Enter a . (period) to display a point (appears as a small square) on
the map, or a # (pound sign) to display the current date and time.

The Map Range field allows you to specify the range at which the landmark should be displayed.
The program determines the number of miles the currently displayed map is in width.  This is the
map range.   If the range you specify, for this landmark, is greater than or equal to the current
map range, it will be shown.

The Show Label option indicates whether you want a box drawn around the text.  Check this box
to draw an outline.

The Notes field allows you to enter comments about this landmark.  This field is not otherwise
used by the software.

The font for the landmark can be selected by clicking on the Font button.  Although each font
field can be manually changed, the recommended method is to use the Font button to select the
font.  The color of the font can be selected by clicking on the color shown next to the Font Color
label.

The Label Background and Label Outline buttons allow you to establish colors for these
respective items.
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12 WxMesgText

12.1 Overview

Weather Message - Message Creator is a support application that can be used to create test
weather messages.  These message can be used to test your alarms, or create local messages
for other alerting purposes.

Message Creator has two modes of operation; Expert and Simple.  The Expert mode allows you
the most flexibility in creating a message.  The Simple mode is more suited for first time users.

Copyright © 2007 Weather Message Software

12.2 Menu Options
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The menu buttons on this screen perform these functions:

The File menu allows you to setup this program, show details, view logfiles, and exit the
program.

• The Open option opens a file dialog box for you to select a message template.
• The Save option saves the message that you open with the original file name.
• The Save As option saves the message that you entered and allows you to enter a file

name.
• The Setup option opens the Setup  window.
• The Exit option shuts down the Message Creator.

Note:  The Open option defaults to the ..\WxMesgNet\WxData\WxLocal directory.  This is
the suggested directory for storing message templates.

The Clear Counties menu, clears any counties selected in the County Selection box.

The Help menu allows you to see this manual, and display information about the program.

12.3 Expert Mode

69
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In the Expert mode, the application attempts to load the default message template file WxProd.txt
from the directory ..\WxMesgNet\WxData\WxLocal.  This directory is used when Opening and
Saving message templates.

The message must be formatted like a standard National Weather Service Message.  You can
view actual NWS products at http://www.wxmesg.com/asp/recprod.asp.  The actual messages
can be used as examples for formatting.

The following special codes can be used in the message:
$WxUTC$ Current UTC time, in the format ddhhmm
$WxExpire$ Expiration time, in the format ddhhmm
$WxDate$ Current local date and time.
$WxVtecIssue$ Issue time for the VTEC line.
$WxVtecExpire$ Expiration time for the VTEC line.
$WxCounties$ The counties selected for this message.

By using these codes, the program will automatically substitute the current UTC time, message
expiration time and the current local date and time in the test message.  This keeps you from
having to manually enter those parameters.  The expiration time is set to 15 minutes after the
current time.  Look at the screen shot above for the proper location of these variables.

You can change the AWIPS ID and other information to agree with the alarm that you want to
test.  To test an alarm, the AWIPS identifier and associated counties must match your alarm in
Weather Message.
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The Select All button will select all of the listed counties.  The Clear button will clear the county
selections.

After you have the test message formatted and worded properly, you can now save the message
for future reference.  Clicking the Save button will save the message using the file name
displayed.

To send the message to Weather Message Server for processing, click the Send button.

12.4 Simple Mode

The Simple mode, as the name implies, is easier to use than the expert mode.  The program
builds the message based on the information that you select or enter on this screen.

The Select All button will select all of the listed counties.  The Clear button will clear the county
selections.

After entering the information for your message, click the Send button to send the message to
Weather Message Server for processing.

Note:  If the product selected does not support VTEC encoding, the VTEC related boxes will
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be disabled.

12.5 Setup
Enter topic text here.

12.5.1 Settings Tab

The Settings Tab is used to set operational information for the Message Creator.

The Expire Minutes field allows you to specify the default number of minutes for the message
expiration.  These minutes are added to the current time to calculated the message expiration
date/time.

Enter your WFO designator in the WFO field.

The Expert Mode, when checked, puts the application in Expert  mode.  When it is
unchecked, the application operates in the Simple  mode.

In order to select counties on the State / Counties Tab, you must enter one or more states in the
State field.  If you enter multiple states, they must be delimited by commas.

The Ingest Path should contain the path to the Weather Message Server received files directory.
This field should be populated by default.
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12.5.2 State / Counties Tab

The Settings Tab is used to select the counties that appear in the County Selection list box.

Place a check mark next to each county that you want to appear in the County Selection list box.
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13 WxScheduler

13.1 Overview

The Weather Message Scheduling application, WxScheduler, is used to schedule user-defined
messages or retrieve internet products

WxScheduler is generally used for two purposes:  to schedule monthly tests of the software and
download weather text or graphics from the Internet.  By allowing text and graphics to be
downloaded from the Internet, weather products not available from EMWIN or Weather Wire can
still be obtained for local use and processing.

You can establish schedules to retrieve messages or graphics from local directories, or from the
Internet using the FTP  or HTTP protocol. The retrieved products are automatically copied to the
ingest directory at the user defined time or interval.

The main processing window shows the current status of WxScheduler.  When it is processing a
message, you will see information about the message scroll in the text box.

To establish schedules see the Schedule Tab .

Note:  If WxScheduler is stopped with the window minimized, the next time it is started, it will
start minimized.

System Tray

When WxScheduler is minimized, you can restore the main screen by right clicking on the
system tray icon , then select open.

Copyright © 2007 Weather Message Software

13.2 Menu Options
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The menu buttons on this screen perform these functions:

The Setup menu opens the Setup Window .

The Notepad menu opens notepad.  This can be used to edit message templates.

The Help menu allows you to see this manual, and display information about the program.

13.3 Creating Text Messages

Before you can begin scheduling user-defined text messages, you must create the messages.
First select or create a directory to store your messages.  You can use C:\Program
Files\WxMesgNet\WxData\WxLocal to store your user-defined messages.  This directory is
automatically created for use by Message Text Creator and can be shared by WxScheduler.  You
can use the Notepad menu option to launch Notepad to create the message.

Hint:  WxMesgText and WxScheduler use the same text message format.  Messages created
can be used by both programs.

Sample Message

The following screen shows a sample message being created for a monthly system test.
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The file name for the message must end with the extension ".txt".  You will also notice that some
special program codes are used in the message.  These special codes tell WxScheduler where
to put special text in the message.

The message must be formatted like a standard National Weather Service Message.  You can
view actual NWS products at http://www.wxmesg.com/asp/recprod.asp.  The actual messages
can be used as examples for formatting.

The following special codes can be used in the message:
$WxUTC$ Current UTC time, in the format ddhhmm
$WxExpire$ Expiration time, in the format ddhhmm
$WxDate$ Current local date and time.
$WxVtecIssue$ Issue time for the VTEC line.
$WxVtecExpire$ Expiration time for the VTEC line.

13.4 Setup

13.4.1 Schedule Tab

The Schedule Tab is used to establish schedules.
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To add, change or delete a scheduled item, click on the line that you want to modify and right
click, then select the appropriate function, Edit or Delete.  When changing an entry, the Edit
Scheduled Item  window is displayed.

Hint:  To send the message immediately, right click and select the Send Now option.

13.4.1.1 Edit Scheduled Item

The Edit Scheduled Item window allows you to enter the specifics about the item being
scheduled.
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Select the Server Type for this alarm: Local, HTTP or FTP.  In the above example, the message
will be obtained locally.

The Server Address, Port, User Name and Password fields are used when you select the
server type HTTP or FTP.  When using HTTP or FTP, enter the appropriate Server Address,
Port, User Name and Password.

Enter the path and name of the file in the File Name field.  For local files, you can use the
Browse button to locate the file.  For HTTP or FTP files, enter the location of the file.

In the Ingest File Name field, enter the name of the file as it should appear when it is copied to
the ingest directory.  The base name of the file should not exceed eight characters.  The total file
name length, including the extension, should be no longer than 12 characters.

Now enter the scheduling information for this message.  The Day of Month, Day of Week, Week
of Month and Month fields can be left blank to indicate "Any".  In the above example, for a
weekly test, the Day of Month, Week of Month and Month fields are left blank.  The Day of Week
is specified.

Hint:  Make sure that the combinations of Day of Month, Day of Week, Week of Month and
Month will occur.  If you select the first day of the month and the second week of the month,
the criteria for this alarm will never occur.

Before entering a time, select the At This Time or Every Time to indicate if this item should be
processed at a specific time or time interval.  Then enter the Time or Time Interval for this item.
The Time must be in 24-hour notation and in the format HH:MM.

The Duration field is used to establish an expiration time for text messages that contain UGC
lines.  It is used to populate the $WxExpire$ variable.   Enter the length of time for this message.
The Duration field must be in the format HH:MM.
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The Send Now field is used to send this scheduled item immediately.  Placing a check mark in
this field and saving the item will cause the scheduler to immediately send this item.

Note:  You must exit back to the main screen before it will be sent.  The scheduler does not
work while you are editing items.

The Disabled field is used to temporarily disable a scheduled item.  When this option is checked,
the scheduled item will not be processed.

Hint:  The Disabled option is useful when you want to send a message on demand.  You can
setup the message with a schedule and then disable the message.  When you want to send
the message, you can right click on the schedule grid and select Send Now.

The Drop Duplicates check box, when checked, will create a CRC32 checksum for each
processed file.  If the next file processed, for a scheduled item, is a duplicate, the program will
not process the file.  This option is useful if you are using WxScheduler to retrieve graphics from
web sites.  In most cases, you do not know when a web site file will change.  This option will
allow you to retrieve a file on a schedule and only process the file when it has changed.

The above screen shows a graphic, from the National Hurricane Center, that is scheduled to be
retrieved from the Internet every 15 minutes, using HTTP.

13.4.2 Settings Tab

The Settings Tab is used to establish general program option.
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The Use Defined Ingest Paths check box, when checked, will cause the program to use the
ingest paths defined in the ingest programs.  If you want to define your own ingest paths for the
scheduler, uncheck this box.

The Timeout field allows you to specify the maximum amount of time the program will wait for
the HTTP or FTP servers to respond.

The FTP – Use Passive Mode option, when checked, will cause the ftp program to use the
passive mode.  This option may be needed for firewalls that restrict incoming connections.

The Firewall / Proxy button allows you to configure Firewall and Proxy settings for your
computer.  See Firewall / Proxy .

13.4.2.1 Firewall / Proxy

The Firewall / Proxy window allows you to configure firewall / proxy information for your
computer.
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For a FTP firewall, enter the domain name or TCP/IP address of the firewall in the Host Name
field.

Enter the Port number for the firewall.

If required, enter a User Name and Password.  This should be a user name and password
setup in the firewall.

Select the Type of firewall.  Valid entries are 1-Tunnel, 2-Socks version 4, or 3-Socks version 5.

For a HTTP firewall, enter the domain name or TCP/IP address of the firewall in the Host Name
field.

Enter the Port number for the firewall.

If required, enter a User Name and Password.  This should be a user name and password
setup in the firewall.
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Select the Type of firewall.  Valid entries are 1-Tunnel, 2-Socks version 4, or 3-Socks version 5.

For a Proxy access, enter the domain name or TCP/IP address of the proxy in the Host Name
field.

Enter the Port number for the firewall.

If required, enter a User Name and Password.  This should be a user name and password
setup for the proxy.

If HTTP version 1.0 is required for the proxy server, check this box.

The Detect Proxy button will automatically detect the proxy settings for your computer and
populate the host name and port fields.

Note:  The Firewall / Proxy settings are common to all Weather Message applications.
Changing these settings will automatically change them for the other applications.

13.4.3 Ingest Paths Tab

The Ingest Paths Tab is used to define the directories that will store the received weather
products for processing.
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.

The Ingest Path is defined in the Weather Message Server setup screen and would not normally
be entered here.

The Additional Distribution Paths can be used to place a copy of the received weather text in
different directories for processing by other programs.  For example, if you use Weather
Message to receive your weather data, you can put a copy of the received messages in a second
or third directory for processing by RealEMWIN or the Weather Message Retransmission
program.

Note:  If the Use Defined Ingest Paths setting is checked, you will not be able to change the
paths listed.
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14 WxRadar

14.1 Overview

WxRadar is a support application that can be used to automatically retrieve radar images.  It can
retrieve a specific radar site for viewing on the screen, or schedule single or multiple radar sites
for ingesting by Weather Message or other programs.  WxRadar requires Internet access.

If you plan to use WxRadar to retrieve images on a schedule, it should be placed in the startup
box in Windows.  This will insure that the program is automatically started each time the
computer is booted.

When scheduling radar images, the images that are received will be copied to directories for
other programs to process.  You can use it in conjunction with Weather Message to FTP images
to a website or WxReTran for EMWIN retransmission.  See Scheduling .

Images processed by Weather Message Server can be made available to the Weather Message
Client Image Viewer.  The Image Viewer can then be used to animate the received radar images.

Note:  If WxRadar is stopped with the window minimized, the next time it is started, it will start
minimized.

System Tray

When WxRadar is minimized, you can restore the main screen by right clicking on the system
tray icon , then select open.
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14.2 Menu Options

The menu buttons on this screen perform these functions:

The File menu allows you to setup this program, view logfile, print the current radar image and
exit the program.

• The Setup option opens the Setup window .
• The View Logfile displays the radar log file in notepad.
• The Print option prints the current radar image on your default printer.
• The Clear Cache option clears the radar cache directory of all static image overlays.
• The Exit option shuts down WxRadar.

The Schedule menu allows you to establish a schedule  to retrieve radar images.

The Retrieve Now menu forces the application to start a retrieve cycle.

 The Help menu allows you to see this manual, and display information about the program.

69
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14.3 Main Window

The main window allows you to quickly retrieve a radar image.  Select the State, Radar Site,
Image type and Layers.  Click the View button to retrieve the image selected.

Hint:  To receive national radar products, select the state abbreviation NA.

The image can be resized to fit the display window or zoomed for closer inspection.  To activate
these features, right click on the image and select one of the displayed options.
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The default view is Zoom 100%.

To print the displayed image, click on the File menu and select Print.  The image will be printed to
your default printer.

Note:  If WxRadar cannot download the requested radar image, a "Radar Unavailable" image
will be displayed.  The "Radar Unavailable" image can be customized by changing the
"RadUnavl.gif" file.

14.4 Scheduling

To schedule radar images for automatic retrieval, click on the Schedule menu.  The main window
will change to allow you to setup schedules.
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Select the State, Radar Site, Image, Layers, File Name for ingest and Interval to retrieve.  Click
on the Add button to schedule that radar site.  To remove a site, click on the site in the list and
click the Delete button.

Hint:  To receive national radar products, select the state abbreviation NA.

Note:  If you do not enter a file name, WxRadar will create the radar file name in the format,
"RAD" plus the last three letters of the radar site plus the 2 digit state abbreviation plus ".gif".
For example, the file name for KMXX would be RADMXXAL.gif.

The scheduled radar images will be retrieved based on the interval period specified.  Valid
intervals are 4, 5, 6, 7, 8, 9, 10, 11, 12, 13, 14, 15, 20, 25, 30, 35, 40, 45, 50, 55 and 60 minutes.

The results of each scheduled retrieve is logged to the file RadLog.txt.  To view this log file, click
on File and View Log.  The log file will contain an entry for each time it attempts to retrieve a
radar image.  It will also contain any error conditions.

Hint:  The scheduled images will be retrieved according to the schedule you establish.  If you
want to retrieve all images immediately, click on the Retrieve Now menu button.

When you are finished entering your schedule, click on the Preview menu.  This returns you to
the Main Window .101
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14.5 Setup

14.5.1 Settings Tab

The Settings Tab is used to define general program operation.

The Timeout field allows you to specific the maximum amount of time the program will wait on
the NOAA servers to respond.

The Log File Size field allows you to specify this size of your log file, RadLog.txt.  The default is
50,000 bytes.

When the program retrieves images from the defined schedule, it does not display these images
in the preview window.  The Show Image check box, when checked, causes the program to
show each image as it is received.

The Use Defined Ingest Paths check box, when checked, will cause the program to use the
ingest paths defined in the ingest programs, WxByte and WxIngest.  If you want to define your
own ingest paths for WxRadar, remove this check.

The Firewall / Proxy button allows you to configure Firewall and Proxy settings for your
computer.  See Firewall / Proxy .

The Image Type list allows you to select an image format for the received image.  Radar images
are received by default in GIF format.  You can select GIF, JPG, PNG, BMP, and TIF formats.

The Drop Duplicates check box, when checked, will create a CRC32 checksum on each
received image.  If the next image received is a duplicate, the program will not process the
image.
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14.5.1.1 Firewall / Proxy

The Firewall / Proxy window allows you to configure firewall / proxy information for your
computer.

For a HTTP firewall, enter the domain name or TCP/IP address of the firewall in the Host Name
field.

Enter the Port number for the firewall.

If required, enter a User Name and Password.  This should be a user name and password
setup in the firewall.

Select the Type of firewall.  Valid entries are 1-Tunnel, 2-Socks version 4, or 3-Socks version 5.

For a Proxy access, enter the domain name or TCP/IP address of the proxy in the Host Name
field.

Enter the Port number for the firewall.
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If required, enter a User Name and Password.  This should be a user name and password
setup for the proxy.

If HTTP version 1.0 is required for the proxy server, check this box.

The Detect Proxy button will automatically detect the proxy settings for your computer and
populate the host name and port fields.

Note:  The Firewall / Proxy settings are common to all Weather Message applications.
Changing these settings will automatically change them for the other applications.

14.5.2 Ingest Paths Tab

The Ingest Paths Tab is used to define the directories that will store the received weather
products for processing.

The Ingest Path is defined in the Weather Message Server setup screen and would not normally
be entered here.

The Additional Distribution Paths can be used to place a copy of the received weather text in
different directories for processing by other programs.  For example, if you use Weather
Message to receive your weather data, you can put a copy of the received messages in a second
or third directory for processing by RealEMWIN or the Weather Message Retransmission
program.

Note:  If the Use Defined Ingest Paths setting is checked, you will not be able to change the
paths listed.
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15 WxLoader

15.1 Overview

WxLoader is a support application that can be used to manage weather content for websites or
provide data for other third-party applications.

If you plan to use WxLoader, it should be placed in the startup box in Windows.  This will insure
that the program is automatically started each time the computer is booted.

Although Weather Message has provisions for uploading weather text and graphics, it does not
monitor expiration dates/times for the uploaded products.  WxLoader, working in conjunction with
Weather Message Server, has the ability to upload text products and monitor the expiration
date/times of these products.  This allows WxLoader to remove expired products and/or replace
the message with user defined text.

WxLoader connects to Weather Message server using TCP/IP and processes the same products
sent to the map client.

Hint:  If the system tray icon is outlined with a red circle or a red led appears in the status bar,
the program is not communicating with the Weather Message Server.

Note:  If WxLoader is stopped with the window minimized, the next time it is started, it will start
minimized.

System Tray

When WxLoader is minimized, you can restore the main screen by right clicking on the system
tray icon , then select open.

Copyright © 2007 Weather Message Software
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15.2 Menu Options

The menu buttons on this screen perform these functions:

The File menu allows you to setup this program, start a processing cycle and exit the program.

• The Setup option opens the Setup window .
• The Connect option forces the application to attempt a connection to the server.
• The Refresh Alarm option clears any active alarms and sends a refresh request to

Weather Message Server.
• The Process Now forces the program to start a processing cycle.
• The Exit option shuts down WxLoader.

The Alarms option displays the Active Alarms  window.

The Help menu allows you to see this manual, and display information about the program.

176
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15.3 Main Window

The main processing window shows the status of WxLoader.  When it is processing tasks, you
will see status messages in the status bar.

WxLoader works by processing products that have been alarmed  to the map client.  This
allows Weather Message Server to handle the alarms and message content while WxLoader
handles uploads and message expirations.

15.4 Alarms

The Active Alarms Menu option allows you to view the current alarms.

The alarm grid display information about each active alarm.  The colums and rows can be
expanded to show hidden information.  The columns and rows can be extended by clicking a row
or column line and dragging the line.  You can also sort the information by clicking on the column
identifier.
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Right click an entry to expire a product or click the Expire All button to expire all active alarms.

The Refresh button will refresh the alarm grid.

Note:  The alarm grid will automatically refresh every 30 seconds.

15.5 Setup

15.5.1 Server Tab

The Server Tab is used to define the communications information to Weather Message Server.

The Host TCP/IP Address is the address of the Weather Message Server.  Enter the address of
your primary server in this field.   The default is 127.0.0.1 for the local computer.

The Host TCP/IP Port is the port defined by Weather Message Server for connections.  The
default is 9501.

The Backup Address is the TCP/IP address of your backup Weather Message Server.  Do not
enter an address in this field if you do not have a backup Weather Message Server.  This
address is used when the program cannot contact your primary Weather Message Server.

The Backup Port is the port defined for use by the backup Weather Message Server.  The
default is 9501.

The Client Identifier field allows you to assign an identification number to WxLoader.  This
identifier can be used, when setting up your alarms , to send a specific product to WxLoader.183
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15.5.2 Program Options Tab

The Settings Tab is used to set operational information for WxLoader.

The Upload On Change option indicates whether WxLoader should process tasks when a new
file arrives or a product expires.  Check this option if you want the program to process tasks
when a new file arrives or a product expires.  If this option is not checked, the process task cycle
will occur based on the Update Every Minutes setting.

The Update Every Minutes option establishes the amount of time, in minutes, to process tasks.
The task processing cycle time can be set from 0 to 60 minutes.  If you set this field to zero
minutes, you must check the Upload On Change option.  Care should be used when setting this
value.  When the specified amount of time lapses, the program will process and upload each
task.

Note:  Setting this value too low can cause the program to get behind when you have a slow
internet connection.

The Log File Size field allows you to specify this size of your log file, LoadLog.txt.  The default is
50,000 bytes.

The Timeout field allows you to specific the maximum amount of time the program will wait on
the HTTP or FTP servers to respond.

The FTP – Use Passive Mode option, when checked, will cause the ftp program to use the
passive mode.  This option may be needed for firewalls that restrict incoming connections.

The Firewall / Proxy button allows you to configure Firewall and Proxy settings for your
computer.  See Firewall / Proxy .33
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15.5.2.1 Firewall / Proxy

The Firewall / Proxy window allows you to configure firewall / proxy information for your
computer.

For a FTP firewall, enter the domain name or TCP/IP address of the firewall in the Host Name
field.

Enter the Port number for the firewall.

If required, enter a User Name and Password.  This should be a user name and password
setup in the firewall.

Select the Type of firewall.  Valid entries are 1-Tunnel, 2-Socks version 4, or 3-Socks version 5.

For a HTTP firewall, enter the domain name or TCP/IP address of the firewall in the Host Name
field.
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Enter the Port number for the firewall.

If required, enter a User Name and Password.  This should be a user name and password
setup in the firewall.

Select the Type of firewall.  Valid entries are 1-Tunnel, 2-Socks version 4, or 3-Socks version 5.

For a Proxy access, enter the domain name or TCP/IP address of the proxy in the Host Name
field.

Enter the Port number for the firewall.

If required, enter a User Name and Password.  This should be a user name and password
setup for the proxy.

If HTTP version 1.0 is required for the proxy server, check this box.

The Detect Proxy button will automatically detect the proxy settings for your computer and
populate the host name and port fields.

Note:  The Firewall / Proxy settings are common to all Weather Message applications.
Changing these settings will automatically change them for the other applications.

15.5.3 Tasks Tab

The Tasks Tab is used to maintain WxLoader tasks.
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The Add, Edit and Delete Task buttons are used to create, change and remove tasks.  You can
also edit tasks by double clicking on the listed task.

15.5.3.1 Editing a Task
15.5.3.1.1  Task Tab

The Edit Task window is used to setup information for a new or selected task.

The Task Name field describes this task.  Use short descriptive names to identify your tasks.
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The Style option is used to specify the type of message to create.  Select Short for a short
message or Full for a full text message.

Here is an example message created with the Short option.

A Tornado Warning has been issued for Tallapoosa county until 9:20 PM.  A
Severe Thunderstorm Watch has been issued for Tallapoosa county until 9:20
PM. 

The Destination File Name is the path and file name that you want the created message to be
named on your server or directory.  This field is required.

Select the type of save, Local, FTP or HTTP.  If FTP or HTTP is selected, the program will allow
you to enter information about your ftp or HTTP server.  Enter the FTP Server address, Port
number, User Name and Password.  These settings will be used to log into your server.

15.5.3.1.2  Products Tab

The Products Tab allows you to specify the products that should be processed for this task.

Select the type of Product Identifers that you intend to load in the Products To Process list.
Product Type can be AWIPS / VTEC, AWIPS or VTEC.

Enter an AWIPS identifier or VTEC phenomena and siginficance to process in the Product
Identifier field.  Click the Add Product button to add this product to the list.

Note:  This product must be alarmed to the map client.

Hint:  Product identifiers can contain the wild card characters * and ?.
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Hint:  AWIPS identifiers can include WFO abbreviations as shown above.  VTEC phenomena
and significance codes do not allow WFO identifiers.

To delete a product, highlight the product and click Delete Product or press the Delete key.

The Expire Adjustment field allows you to modify the expiration times of received products.  For
example you could specify –10 or +10 minutes.  In some applications, you may want the
message to remain active longer than the actual expiration time.  In other applications, you may
want the message to expire before the actual expiration time.

The Expire After Minutes option is used to expire products that do not contain an expiration
date/time.  Products that do not contain UGC lines do not have an expiration date/time.  The
amount of time specified for this option will be added to the product issue date/time to determine
the expiration date/time.  This value does not effect products that contain UGC lines.

Hint:  If you alarm products that do not contain UGC lines, you should enter a value in the Expire
After Minutes field.  Failing to do so will result in the message expiring immediately.

15.5.3.1.3  HTML Tab

The HTML Tab allows you to enter HTML code to be included when processing this task.
Normally, HTML code is used to encapsulate the message.

If you will be using HTML code, enter the HTML code in the text box.  Remember to use the
variable $MESSAGE$ in this code as a place marker for your text.  The Load Template button
can be used to load a template file or a file containing html code.  When loading templates, the
program automatically looks for templates in ..\WxMesgNet\WxData\Template.

Note:  If a html template is specified, the program will change any html reserved-characters in
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the weather text to their corresponding html abbreviation.  This prevents html browsers from
misinterpreting the weather text as html code.

Note:  See Publishing Data to a Web Page for examples.

15.5.3.1.4  File Separator Tab

The File Separator Tab allows you to enter text to be inserted between each product.

If you want text inserted between each product, enter it in the text box.  This field is not required
and can be left blank.

15.5.3.1.5  Default Message Tab

The Default Message Tab allows you to specify text to be uploaded when there are no active
messages for this task.
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Enter the default message text in the text box.  This field is not required and can be left blank.

15.6 Alarm Setup

In order for WxLoader to have products to process, the desired products must be alarmed in
Weather Message Server.  This is accomplished by setting up an alarm in Weather Message and
sending the product to the map client.
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If you only want to alarm a product to WxLoader, select the client identifer in the To Map box.
This is the same client identifier selected on the Server Tab .106
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16 WxWire - Weather Wire Utility

16.1 Overview

WxWire is a support application that can be used to send messages to a serial port in weather
wire format.

The Ingest Path is the directory path where WxWire should pickup the files archived by Weather
Message Server.  This path is initially empty.  You will need to decide on a common directory
path that will be used by WxWire to receive files and Weather Message Server to store files.  The
suggested path, "C:\Program Files\WxMesgNet\WxWire", can be used for this purpose.

Set the Comm Port and Baud Rate as required by your external equipment or software.

The Add Header option, when selected, will add an expanded header to the first line of the
message.  This option expands the AWIPS identifier and makes it the first line in the message.

The Remove Return option, when selected, will remove the extra return character from
processed messages.

Click on PIL Format to send messages in PIL format.  Click on WMO Format to send messages
in WMO format.  This setting depends on the application that will be receiving the data.

The Stop button can be used to pause the file that is currently being sent.  This button will toggle
between Stop and Start.

Note:  You must click the Stop button to make changes to the Settings.

Copyright © 2007 Weather Message Software
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17 Supplement

17.1 Weather Forecast Office Abbreviations



Supplement 189

© 2007 Weather Message Software

17.2 Text Product Abbreviations
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17.3 State / Marine Zone Abbreviations
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17.4 Graphical Product Names
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17.5 Paging / E-Mail Formats

Weather Message supports a number of paging and e-mail formats, ranging from the full
message text to a short message for pagers/cell-phones.  This section gives examples of the
different formats.

The following paging / e-mail formats are available:  Full, Full No Head, Selected, Selected No
Head and Short.   In addition, the message can be broken down into a number of packets for
distribution to pagers / cell-phones.  The system will allow you to specify the size of these
packets and the number of packets to send.

For messages sent via e-mail, you can specify the type of subject line sent.  You can send no
subject line, the product identifier, or a text description of the product.

Regardless of the format selected, the system has a parse option that allows you to abbreviate or
remove words from the paged / e-mailed message.

The following tornado warning will be used in the examples.

WFUS54 KBMX 192255
TORBHM
ALC113-192330-
 
BULLETIN - EAS ACTIVATION REQUESTED
TORNADO WARNING
NATIONAL WEATHER SERVICE BIRMINGHAM AL
455 PM CST WED MAR 19 2003
 
THE NATIONAL WEATHER SERVICE IN BIRMINGHAM HAS ISSUED A
 
* TORNADO WARNING FOR...
  RUSSELL COUNTY IN SOUTHEAST ALABAMA
 
* UNTIL 530 PM CST
 
* AT 455 PM CST...NATIONAL WEATHER SERVICE DOPPLER RADAR INDICATED A
TORNADO NEAR FORT MITCHELL...MOVING NORTHEAST AT 25 MPH. THIS STORM
WILL AFFECT RURAL EASTERN RUSSELL COUNTY.
 
IF YOU ARE NEAR THE PATH OF THIS TORNADO...TAKE COVER IN AN INTERIOR
ROOM ON THE LOWEST FLOOR...OR A BASEMENT. ABANDON MOBILE HOMES AND
VEHICLES FOR MORE SUBSTANTIAL SHELTER.
 
CALL 1-800-856-0758 TO REPORT SEVERE WEATHER.
 
LAT...LON 3229 8514 3213 8504 3226 8492 3247 8499
 
$$

The Full option will send the message above exactly as printed.

The Full No Head option will be sent without the heading information.  Here is an example.

THE NATIONAL WEATHER SERVICE IN BIRMINGHAM HAS ISSUED A
 
* TORNADO WARNING FOR...
  RUSSELL COUNTY IN SOUTHEAST ALABAMA
 
* UNTIL 530 PM CST
 
* AT 455 PM CST...NATIONAL WEATHER SERVICE DOPPLER RADAR INDICATED A
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TORNADO NEAR FORT MITCHELL...MOVING NORTHEAST AT 25 MPH. THIS STORM
WILL AFFECT RURAL EASTERN RUSSELL COUNTY.
 
IF YOU ARE NEAR THE PATH OF THIS TORNADO...TAKE COVER IN AN INTERIOR
ROOM ON THE LOWEST FLOOR...OR A BASEMENT. ABANDON MOBILE HOMES AND
VEHICLES FOR MORE SUBSTANTIAL SHELTER.
 
CALL 1-800-856-0758 TO REPORT SEVERE WEATHER.
 
LAT...LON 3229 8514 3213 8504 3226 8492 3247 8499
 
$$

The Short format allows you to select certain elements of the message to send.  For example, if
you set up your short message format as follows:

NWS $WFO$ has issued a $MesgType$ $HeadLine$$IfCounty: for $$Counties$$IfCounty:
County$$IfExpire: Until $$Expire$ - $BulletAT$

Results in a message like this:

NWS BHM has issued a Tornado Warning  for Russell County Until 05:30 PM - AT
455 PM CST...NATIONAL WEATHER SERVICE DOPPLER RADAR INDICATED A TORNADO NEAR
FORT MITCHELL...MOVING NORTHEAST AT 25 MPH. THIS STORM WILL AFFECT RURAL
EASTERN RUSSELL COUNTY.

The Selected option only sends the text associated with the UGC group associated with the
county that was alarmed.  Some messages contain multiple groups.  A good example is the zone
forecast.  It contains multiple groups

FPUS54 KBMX 052153
ZFPBHM

ZONE FORECAST PRODUCT
NATIONAL WEATHER SERVICE BIRMINGHAM AL
405 PM CST SAT APR 5 2003

ALZ011>015-017-060930-
BLOUNT-FAYETTE-LAMAR-MARION-WALKER-WINSTON-
INCLUDING THE CITIES OF...DOUBLE SPRINGS...FAYETTE...HAMILTON...
JASPER...ONEONTA...VERNON
405 PM CST SAT APR 5 2003

.TONIGHT...INCREASING CLOUDS.  A SLIGHT CHANCE OF A SHOWER AFTER
MIDNIGHT.  LOWS IN THE LOWER 50S.  NORTHEAST WINDS 5 TO 10 MPH.
CHANCE OF RAIN 20 PERCENT.
.SUNDAY...MOSTLY CLOUDY WITH SHOWERS AND THUNDERSTORMS LIKELY BY
AFTERNOON.  STORMS POSSIBLY SEVERE IN THE AFTERNOON.  HIGHS IN
THE LOWER 70S.  EAST WINDS 10 TO 15 MPH...BECOMING SOUTHEAST IN THE
AFTERNOON.  CHANCE OF RAIN 70 PERCENT.
.SUNDAY NIGHT...SHOWERS AND THUNDERSTORMS.  STORMS POSSIBLY SEVERE.
LOWS IN THE LOWER 60S.  SOUTHEAST WINDS 10 TO 15 MPH.  CHANCE OF RAIN
80 PERCENT.
.MONDAY...VARIABLE CLOUDINESS WITH A CHANCE OF THUNDERSTORMS.  HIGHS
IN THE UPPER 70S.  CHANCE OF RAIN 30 PERCENT.
.MONDAY NIGHT...PARTLY CLOUDY WITH A SLIGHT CHANCE OF SHOWERS.
LOWS IN THE MID 50S.  CHANCE OF RAIN 20 PERCENT.
.TUESDAY...MOSTLY CLOUDY AND COOLER WITH A CHANCE OF SHOWERS.  HIGHS
60 TO 65.  CHANCE OF RAIN 30 PERCENT.
.WEDNESDAY AND THURSDAY...MOSTLY CLOUDY WITH A CHANCE OF SHOWERS
EACH DAY.  LOWS IN THE MID 40S.  HIGHS 60 TO 65.
.FRIDAY...PARTLY CLOUDY.  LOWS IN THE MID 40S.  HIGHS 65 TO 70.
.SATURDAY...PARTLY CLOUDY.  LOWS NEAR 50.  HIGHS IN THE MID 70S.
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$$

ALZ018>020-022>024-026-060930-
CALHOUN-CHEROKEE-ETOWAH-JEFFERSON-PICKENS-ST CLAIR-TUSCALOOSA-
INCLUDING THE CITIES OF...ANNISTON-JACKSONVILLE...
BIRMINGHAM-HOOVER...CARROLLTON...CENTRE...GADSDEN...
PELL CITY-ASHVILLE...TUSCALOOSA
405 PM CST SAT APR 5 2003

.TONIGHT...VARIABLE CLOUDINESS WITH A SLIGHT CHANCE OF A
SHOWER.  LOWS IN THE MID 50S.  LIGHT WINDS.  CHANCE OF RAIN 20
PERCENT.
.SUNDAY...MOSTLY CLOUDY WITH SHOWERS AND THUNDERSTORMS LIKELY BY
AFTERNOON.  STORMS POSSIBLY SEVERE IN THE AFTERNOON.  HIGHS 73 TO
77.  EAST WINDS 10 TO 15 MPH...BECOMING SOUTHEAST IN THE AFTERNOON.
CHANCE OF RAIN 70 PERCENT.
.SUNDAY NIGHT...SHOWERS AND THUNDERSTORMS.  STORMS POSSIBLY SEVERE.
LOWS IN THE MID 60S.  SOUTHEAST WINDS 10 TO 15 MPH.  CHANCE OF
RAIN 80 PERCENT.
.MONDAY...VARIABLE CLOUDINESS WITH A CHANCE OF THUNDERSTORMS.  HIGHS
IN THE UPPER 70S.  CHANCE OF RAIN 30 PERCENT.
.MONDAY NIGHT...PARTLY CLOUDY WITH A SLIGHT CHANCE OF SHOWERS.
LOWS IN THE MID 50S.  CHANCE OF RAIN 20 PERCENT.
.TUESDAY...MOSTLY CLOUDY AND COOLER WITH A CHANCE OF SHOWERS.  HIGHS
IN THE MID 60S.  CHANCE OF RAIN 30 PERCENT.
.WEDNESDAY AND THURSDAY...MOSTLY CLOUDY WITH A CHANCE OF SHOWERS
EACH DAY.  LOWS IN THE MID 40S.  HIGHS 60 TO 65.
.FRIDAY...PARTLY CLOUDY.  LOWS IN THE MID 40S.  HIGHS 65 TO 70.
.SATURDAY...PARTLY CLOUDY.  LOWS NEAR 50.  HIGHS IN THE MID 70S.

$$

You will notice that this message contains two groups.  Each group starts with the code "ALZ".
Using the Selected option and alarming for ALZ011, Blount County, you will receive the following
text:

BLOUNT-FAYETTE-LAMAR-MARION-WALKER-WINSTON-
INCLUDING THE CITIES OF...DOUBLE SPRINGS...FAYETTE...HAMILTON...
JASPER...ONEONTA...VERNON
405 PM CST SAT APR 5 2003

.TONIGHT...INCREASING CLOUDS.  A SLIGHT CHANCE OF A SHOWER AFTER
MIDNIGHT.  LOWS IN THE LOWER 50S.  NORTHEAST WINDS 5 TO 10 MPH.
CHANCE OF RAIN 20 PERCENT.
.SUNDAY...MOSTLY CLOUDY WITH SHOWERS AND THUNDERSTORMS LIKELY BY
AFTERNOON.  STORMS POSSIBLY SEVERE IN THE AFTERNOON.  HIGHS IN
THE LOWER 70S.  EAST WINDS 10 TO 15 MPH...BECOMING SOUTHEAST IN THE
AFTERNOON.  CHANCE OF RAIN 70 PERCENT.
.SUNDAY NIGHT...SHOWERS AND THUNDERSTORMS.  STORMS POSSIBLY SEVERE.
LOWS IN THE LOWER 60S.  SOUTHEAST WINDS 10 TO 15 MPH.  CHANCE OF RAIN
80 PERCENT.
.MONDAY...VARIABLE CLOUDINESS WITH A CHANCE OF THUNDERSTORMS.  HIGHS
IN THE UPPER 70S.  CHANCE OF RAIN 30 PERCENT.
.MONDAY NIGHT...PARTLY CLOUDY WITH A SLIGHT CHANCE OF SHOWERS.
LOWS IN THE MID 50S.  CHANCE OF RAIN 20 PERCENT.
.TUESDAY...MOSTLY CLOUDY AND COOLER WITH A CHANCE OF SHOWERS.  HIGHS
60 TO 65.  CHANCE OF RAIN 30 PERCENT.
.WEDNESDAY AND THURSDAY...MOSTLY CLOUDY WITH A CHANCE OF SHOWERS
EACH DAY.  LOWS IN THE MID 40S.  HIGHS 60 TO 65.
.FRIDAY...PARTLY CLOUDY.  LOWS IN THE MID 40S.  HIGHS 65 TO 70.
.SATURDAY...PARTLY CLOUDY.  LOWS NEAR 50.  HIGHS IN THE MID 70S.

The Selected No Head will result in:
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.TONIGHT...INCREASING CLOUDS.  A SLIGHT CHANCE OF A SHOWER AFTER
MIDNIGHT.  LOWS IN THE LOWER 50S.  NORTHEAST WINDS 5 TO 10 MPH.
CHANCE OF RAIN 20 PERCENT.
.SUNDAY...MOSTLY CLOUDY WITH SHOWERS AND THUNDERSTORMS LIKELY BY
AFTERNOON.  STORMS POSSIBLY SEVERE IN THE AFTERNOON.  HIGHS IN
THE LOWER 70S.  EAST WINDS 10 TO 15 MPH...BECOMING SOUTHEAST IN THE
AFTERNOON.  CHANCE OF RAIN 70 PERCENT.
.SUNDAY NIGHT...SHOWERS AND THUNDERSTORMS.  STORMS POSSIBLY SEVERE.
LOWS IN THE LOWER 60S.  SOUTHEAST WINDS 10 TO 15 MPH.  CHANCE OF RAIN
80 PERCENT.
.MONDAY...VARIABLE CLOUDINESS WITH A CHANCE OF THUNDERSTORMS.  HIGHS
IN THE UPPER 70S.  CHANCE OF RAIN 30 PERCENT.
.MONDAY NIGHT...PARTLY CLOUDY WITH A SLIGHT CHANCE OF SHOWERS.
LOWS IN THE MID 50S.  CHANCE OF RAIN 20 PERCENT.
.TUESDAY...MOSTLY CLOUDY AND COOLER WITH A CHANCE OF SHOWERS.  HIGHS
60 TO 65.  CHANCE OF RAIN 30 PERCENT.
.WEDNESDAY AND THURSDAY...MOSTLY CLOUDY WITH A CHANCE OF SHOWERS
EACH DAY.  LOWS IN THE MID 40S.  HIGHS 60 TO 65.
.FRIDAY...PARTLY CLOUDY.  LOWS IN THE MID 40S.  HIGHS 65 TO 70.
.SATURDAY...PARTLY CLOUDY.  LOWS NEAR 50.  HIGHS IN THE MID 70S.

With each of the above messages, the parse option can be used to remove and shorten some of
the words in the weather text.  Replacement words are entered in the WxWords.dat file.  For
example to replace "NATIONAL WEATHER SERVICE" with "NWS", you would enter "NATIONAL
WEATHER SERVICE,NWS" in your WxWords file.

Using our short message format from above:

NWS BHM has issued a Tornado Warning  for Russell County Until 05:30 PM - AT
455 PM CST...NATIONAL WEATHER SERVICE DOPPLER RADAR INDICATED A TORNADO NEAR
FORT MITCHELL...MOVING NORTHEAST AT 25 MPH. THIS STORM WILL AFFECT RURAL
EASTERN RUSSELL COUNTY.

This message could be changed to.

NWS BHM has issued a Tornado Warning  for Russell County Until 05:30 PM - AT
455 PM ...NWS RADAR INDICATED A TORNADO NEAR FT MITCHELL...MOVING NE AT 25
MPH. STORM WILL AFFECT RURAL E RUSSELL COUNTY.

The parser is case sensitive, so consider this as you setup your WxWords.  COUNTY will not
match County.

Several Weather Message users have already created extensive WxWords.dat libraries.  If you
want a file that is pre-loaded with words, check the Weather Message Miscellaneous Downloads
or send e-mail to the Weather Message Yahoo group.

17.6 Publishing Data to a Web Page

You can send files or html to a website by putting a ftp command in the
Archive Path field on the alarm setup screen. Here are the steps to ftp weather messages.

1. Setup an alarm for the product to be sent to the website.

2. Select the type of archive, Selected or Full. (Full sends the complete  weather message).

3. On this alarm, select the HTML Template option and enter your ftp server information.
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To send a HTML file, you will need to create a template file and place it in the
WxMesgNet\WxData\Template directory. In your html template, enter the code $MESSAGE$
where you want the weather text to be inserted. You will change the HTML Template option to
include the name of your template file.

Here is some additional information on creating a web page with Weather Message.

Server Side Includes

The sample weather page, on the Weather Message website was created by using server-side
includes (SSI).  If your web server supports this capability, it can help you make a nice page.
Feel free to use the html code on the WxMesg sample page,
http://www.wxmesg.com/weather/currentweather.shtm

Basically SSI allows you to copy (include) text files into a web page. Here is some of the html
code used to show the state weather round up.

<textarea rows="5" name="SWRAL" cols="74"><!--#include file="swral"--
></textarea>

The <!--#include file="swral"--> statement actually copies the swral file into the web page,
when a user requests the page.  By including the file when the user requests the web page, they
will always get the latest messages.

HTML Templates

A html template is a web page that will be used by Weather Message to insert the weather text.
Weather Message takes your html template and searches for the code $MESSAGE$ and
replaces that code with the weather text.

I use FrontPage to create a blank page, or one with some text/formatting and put the code
$MESSAGE$ where I want the weather text to appear. This "template" is stored in the WxMesg
directory.  The ftp command will need to include the template name. Weather Message will take
this template, insert the weather text and then ftp that html file to the server.  You will need to
have a main web page that has a link to this uploaded html file.

Note:  If you use the html tags <PRE> </PRE> around the weather text, the text will be properly
formatted.

Here is a sample template.

<html>
<head>
<meta http-equiv="Content-Language" content="en-us">
<meta http-equiv="Content-Type" content="text/html; charset=windows-1252">
<title>Weather Message Sample Template</title>
</head>
<body>
<p align="center">Weather Message Sample Template</p>
<p align="center">Weather Text Follows</p>
<p align="center">&nbsp;</p>
<p align="left"><PRE>$MESSAGE$</PRE></p>
</body>
</html>

When you use the template option, you only get one message per template. For this reason,
most people will want to use server side includes. With server side includes, you are not limited.
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Note:  The first line of the template should begin with <html>.  When a template begins with
<html>, Weather Message will replace any HTML reserved-characters, found in the weather
text, with their appropriate HTML abbreviation.  This prevents html browsers from
misinterpreting the weather text as html code.

17.7 Sending HTML Email

Weather Message allows you to send HTML encoded email.  This is accomplished by setting up
a Header and Trailer for the email group.

Enter the HTML code that should precede the weather text.  Here is some sample code:

<html>
<head>
<META http-equiv=Content-Type content="text/html; charset=iso-8859-1">
<META content="MSHTML" name=GENERATOR>
</head>
<body bgColor=#ffffff>
<p align="center">Test Weather Message</p>
<p align="center">&nbsp;</p>
<p align="left"><PRE>

Next enter the HTML code that should follow the weather text.  Here is some sample code:

</PRE>
</body>
</html>

HTML coding allows you to include links to other websites and format the message with different
fonts and colors.

Note:  The first line of the Header should begin with <html>.  When a Header begins with
<html>, Weather Message will replace any HTML reserved-characters, found in the weather
text, with their appropriate HTML abbreviation.  This prevents html browsers from
misinterpreting the weather text as html code.

17.8 What is EMWIN

EMWIN stands for the Emergency Managers Weather Information Network.  It is a service
provided free by the National Weather Service.  EMWIN is a data stream broadcasted by the
National Weather Service for use by emergency managers and others.  This data stream
contains current weather warnings, watches, images, advisories and forecasts issued by the
National Weather Service.

The information present in the EMWIN data stream originates from local weather service offices
and other sources.  This information is collected at the National Weather Service office in Silver
Spring, Maryland.  From there, it is up-linked to the GOES weather satellites from a transmission
site in Wallops Island, Virginia.  

There are three methods to receive EMWIN data.  You can obtain it directly from the GOES
weather satellites with a satellite receiver.  If the EMWIN signal is being broadcasted on a VHF or
UHF frequency in your area, you can receive it using a low cost scanner and decoder.  It is also
available through an Internet connection.  Each method requires different hardware and/or
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software combinations.  A list of hardware vendors is available from the National Weather
Service EMWIN Vendors web page.

Who can benefit from EMWIN?

• Emergency Management Directors
• Public Safety Officials
• Amateur Radio Operators
• Business Owners
• Media Outlets
• Weather Hobbyists
• Schools
• Hospitals
•

Anyone who has a need for up-to-date weather information can benefit from EMWIN.

For additional information on EMWIN, visit the National Weather Service's EMWIN Information
web page.

Weather Message uses this data stream to provide desktop alerts of impending weather
situations.

17.9 What is Weather Wire

The National Oceanic and Atmospheric Administration Weather Wire Service, NWWS, is a
satellite broadcast system that delivers critical National Weather Service information. CSC
Systems & Solutions operates NWWS.  This service is available using their proprietary C-band
service or Internet connection.  This system routinely delivers 99 percent of all messages within
six seconds.

Established in October 2000, the system collects data from 141 U.S. Weather Centers and
special centers around the country and broadcasts a continuous stream of alphanumeric
information.  Users may receive as much of the information as they want, for a low, fixed annual
fee. Current customers include radio, television and cable stations; universities; state and federal
emergency management services; and many other government agencies.

For more information on NWWS see DynCorp's website at http://www.weatherwire.net or
NOAA's website at http://www.nws.noaa.gov/nwws/.

17.10 What is NOAAPort

The National Oceanic and Atmospheric Administration's NOAAPORT broadcast system provides
a one-way broadcast of NOAA environmental data and information in near-real time to NOAA
and external users. This broadcast service is implemented by communications utilizing C-band.

The NOAAPORT data stream is located on Satellite AMC-4, transponder 13C.  It is broadcast
using DBV formatting, allowing inexpensive equipment to be used to demodulate the data.

This transponder presently has 4 logical channels, NCEP/NWSTG, GOES, NCEP/NWSTG2, and
Non-GOES Imagery/DCP Data.  The NCEP/NWSTG, GOES, and NCEP/NWSTG2 channels
have a data rate of 1.536 Mbps, while the Non-GOES Imagery/DCP Data channel has a data
rate of 768 Kbps.
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For more information on NOAAPort see NOAA's website at
http://www.nws.noaa.gov/noaaport/html/noaaport.shtml.  Weather Message's WxPort ingest
engine processes one of the 4 data streams for use by Weather Message and other software
applications.  





Part
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18 Software License

LICENSE AGREEMENT

I. LICENSE GRANT.
Danny Lloyd, hereafter referred to as Author, grants you a non-exclusive license to use the
software known as WxMesg, or Weather Message, hereafter referred to as Software.

II. DISCLAIMER OF WARRANTY.
Software is provided on an "AS IS" basis, without warranty of any kind, including without
limitation the warranties of merchantability, fitness for a particular purpose and non-
infringement. The entire risk as to the quality and performance of the Software is borne by you.
Should the Software prove defective, you and not Author assume the entire cost of any service
and repair. In addition, the security mechanisms implemented by Author software have
inherent limitations, and you must determine that the Software sufficiently meets your
requirements. This disclaimer of warranty constitutes an essential part of the agreement.
SOME JURISDICTIONS DO NOT ALLOW EXCLUSIONS OF AN IMPLIED WARRANTY, SO
THIS DISCLAIMER MAY NOT APPLY TO YOU AND YOU MAY HAVE OTHER LEGAL
RIGHTS THAT VARY BY JURISDICTION.

III. SCOPE OF GRANT.
You may:
• use the Weather Message Server on one computer;
• use the Weather Message Message Client and Map Client on any number of computers, up

to the capacity of Weather Message Server.
• copy the Software for archival purposes, provided any copy must contain all of the original

Software's proprietary notices.
  You may not:
• permit other individuals to use the Software except under the terms listed above;
• modify, translate, reverse engineer, decompile, disassemble (except to the extent applicable

laws specifically prohibit such restriction), or create derivative works based on the Software;
• rent, lease, grant a security interest in, or otherwise transfer rights to the Software; or
• remove any proprietary notices or labels on the Software.

IV. TITLE.
Title, ownership rights, and intellectual property rights in the Software shall remain in Author.
The Software is protected by copyright laws. Title and related rights in the content accessed
through the Software is the property of the applicable content owner and may be protected by
applicable law. This License gives you no rights to such content.

V. TERMINATION.
The license will terminate automatically if you fail to comply with the limitations described
herein. On termination, you must destroy all copies of the Software.

VI. LIMITATION OF LIABILITY.
UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, TORT, CONTRACT, OR
OTHERWISE, SHALL AUTHOR OR ITS SUPPLIERS OR RESELLERS BE LIABLE TO YOU
OR ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES OF ANY CHARACTER INCLUDING, WITHOUT LIMITATION,
DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR
MALFUNCTION, OR ANY AND ALL OTHER COMMERCIAL DAMAGES OR LOSSES. IN NO
EVENT WILL AUTHOR BE LIABLE FOR ANY DAMAGES IN EXCESS OF THE AMOUNT
AUTHOR RECEIVED FROM YOU FOR A LICENSE TO THE SOFTWARE, EVEN IF AUTHOR
SHALL HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY
CLAIM BY ANY OTHER PARTY. THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO
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LIABILITY FOR DEATH OR PERSONAL INJURY TO THE EXTENT APPLICABLE LAW
PROHIBITS SUCH LIMITATION. FURTHERMORE, SOME JURISDICTIONS DO NOT
ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL
DAMAGES, SO THIS LIMITATION AND EXCLUSION MAY NOT APPLY TO YOU.

VII. HIGH RISK ACTIVITIES.
The Software is not fault-tolerant and is not designed, manufactured or intended for use or
resale in computer systems, in which the failure of the Software could lead directly to death, or
personal injury. Author specifically disclaim any express or implied warranty of fitness for High
Risk Activities.

VIII. MISCELLANEOUS.
This Agreement represents the complete agreement concerning this license and may
amended only by a writing executed by both parties. If any provision of this Agreement is held
to be unenforceable, such provision shall be reformed only to the extent necessary to make it
enforceable. This Agreement shall be governed by the laws of the state of Alabama.


